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GENERAL USE AND OVERVIEW

. POLICY: Quality Control and Quality Assurance will be performed according to

the standards set forth in this Manual and any additional amendments or
addendums thereof.

. PURPOSE: The purpose of this Manual is to provide for the publication of a

written document prescribing the quality standards that all DFW projects,
regardless of size, will be held to.

. GUIDELINES FOR IMPLEMENTATION: This Manual outlines the general

requirements applicable to all projects / or improvements as well as providing
guidance relating to materials, equipment and quality requirements for
individual items of work as defined in this Manual and/or the contract
documents.

. RESPONSIBILITIES: DFW employees, contractors, consultants and suppliers

will implement these quality procedures and standards as published in this
Manual.

. ACCESSIBILITY: Copies of this Manual may be obtained from the DFW DCC

QA Manager but are subject to the U.S. Copyright Act of 1976 and U.S.
Circular 92. Copies may not be released, used or reproduced unless the
appropriate written permission is provided by the QA Manager.

NOTICE: This Quality Assurance Manual supersedes any other earlier versions of the
Manual and its implementation as of the date identified below.

Approved:

(DFW Sr. Quality Assurance Manager) (Date)

(DFW Authorized Manager) (Date)
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Il. OWNERPROCLAMATION AND MISSION
STATEMENT ON QUALITY

It is the mission of DFW Quality Assurance Department that all construction projects be
planned, designed, and constructed with the highest regard for quality. The ultimate
goal is to deliver continuous improvements while building long lasting relationships with
our customers, based on quality, satisfaction, and personal attention on every project
and for every stakeholder. We are committed to the development and implementation
of our company wide quality assurance and quality control process solely focused on
this mission.

lll. POLICY ADMINISTRATION

The DFW Design, Code and Construction Department (DCC), along with the other
Department leaders and the Construction Management Staff are responsible for the
implementation of the Quality Policy. This is the only way to create a true
administration-wide “Quality Culture”. The following manual establishes the policies and
procedures guide coupled with good industry practices to provide a foundation for a
quality system.

The requirements set forth in the manual shall be applied to, and adhered to, on all
DCC-managed projects.

This manual should be used in concert with the other developed construction manuals
and should often be reviewed for applicability and updated in accordance with this
dynamic and ever-challenging industry.

IV. QA DEPARTMENT ROLES AND RESPONSIBILITIES

Sr. QA Manager:
e Lead office role of QA Department
e Direct and advise QA Manager(s)
e Liaison between DCC leadership and QA Managers and Inspectors
e Responsible for updates to Project QA Manual

QA Manager:
e Lead field role of QA Department
e Direct and advise QA Inspectors
e Manage project assignments and schedules for QA Inspectors

QA Inspectors:

Carry out the Quality Assurance procedures for all DCC projects

Daily Point of Contact representing DFW to Contractor

Records all project related construction activity, quantities, testing
Primary source for identifying Issues, Deficiencies, Non-conformances
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V. MANAGEMENT UNDERSTANDING AND
COMMITMENT

1. Quality Assurance Involvement and Applicability

a. It is the intent and expectation of DFW DCC Management that each and every
DCC-managed project will include an appropriate level of QA Department
involvement and shall follow the requirements set forth in this manual.

b. Based on the individual requirements of each project, the QA Manager will
determine the appropriate level of QA Department involvement in the project,
based on such factors as project scope, complexity, duration, and other
factors as determined by the QA Manager, in consultation with the Project
Manager. See Section VII. Minimum Project QA Requirements.

c. Once determined, the Project team will fully adhere to the QA requirements as
set forth by the QA Manager.

2. Quality Culture Policy

d. Each project will have a “Quality Policy Statement” which identifies itself with
the overall DFW Quality Policy

e. The Policy Statement will be posted in each project office of both the
Contractor and Owner.

3. Periodic Office Quality Reviews

a. Procedures will be established to provide for the management personnel to
review Quality issues and to ensure participation and the overall effectiveness
of the Quality Program and Policy.

b. Quality will be the second item on ALL construction progress meeting
agendas, second only to Safety.

4. Management Commitment to the Quality Culture Policy

a. Management will:

i. Provide adequate resources, including but not limited to funding,
personnel, equipment and materials, to implement the policy.

ii. Support quality objectives independent from production personnel.

iii. Lead and participate in quality training.

iv. Promote quality recognition.

v. Encourage self-reporting of all quality related issues and/or concerns.

5. Visualization of Quality Culture Demonstrated

a. Office

vi. Quality posters, lessons learned, and root cause analysis will be posted
in the office and the field

6. Management Using the “8 Points of Quality” System (See Section VII.)
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VI. MINIMUM PROJECT QA STAFFING
REQUIREMENTS

Each project shall have, at a minimum, the following QA Resources:

¢ 1 QA Inspector onsite for each project area (location) under construction

e For Airfield projects, QA Inspector must be present any time Contractor is working
on the AOA.

e For Landside and Facilities projects, minimum 1-2 hours per day, each day for the
duration of construction

Each QA Inspector shall be supplied with the following at a minimum:

e Personal Protective Equipment (PPE)

e Digital Camera

e iPad or Tablet with BIM360, Unifier and other required software as determined by
QA Manager

¢ AOA permitted vehicle, if applicable
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VIl. THE 8 POINTS OF QUALITY

1. Leadership
» Quality Control vs. Production
2. Ownership
» You own the work.
» Would you put your name on it?
3. Expectations
» Hold Points
» What should the final product be?
4. Responsibility
» Rework = Failure
» Would you buy the product if you were the client?
5. Teamwork
» Quality Control with Production
» Quality Assurance with Quality Control
6. Communication
» Plan Ahead!
> Inspection / Activity notification
7. Coordination
» Two-week look-ahead schedule
» Morning QC meetings to discuss the day’s activities
8. Respect
> Needed to develop good practices
» Must think of QC, Production and QA as the same.
» Share a common goal to deliver the best product possible.
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VIIl. QUALITY CONTROL & QUALITY ASSURANCE

Quality Control (QC) is defined as:

The plans, policies and procedures developed for and used by the Contractor to
control the workmanship of a project.

Quality Control Plan* is defined as:

The written Contractor deliverable that details how the Contractor intends to
manage the quality requirements of the project as defined by the contract
documents.

The primary function of the contractor quality control (CQC) is to assure that the
completed project meets all quality requirements of the contract. To guide the
contractor in this task, a CQC plan must be prepared to ensure that the required
standards of quality construction are met. In the CQC plan, the contractor defines
the procedures by which he will manage and control his own, subcontractor’s and
supplier’s’ activities so that the completed project complies with contract
requirements.

*Although this is a lose definition, the elements should be defined by the technical
specification governing the quality policy. In addition, the specifications are only developed
to meet the minimum requirements.

Quality Assurance (QA) is defined as:

The process or procedure DFW will follow to ensure that the required quality of the
project is achieved. This includes the inspection requirements, the timing of the
inspections, written report, and who is to receive and review them, and if any need
for correction who and how it will be done, with the appropriate defined follow up.

In other terms, QA involves the means by which DFW protects its interests.
Through reviews, inspections, and tests, DFW assures that the CQC is working
effectively, and that the end product complies with the quality established by the
contract.
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IX. WRITING GUIDELINES

Adhering to the following guidelines will help ensure that your written entries are as
detailed, accurate and understandable as possible:

what occurred.

Use simple, everyday words that are easy to understand.

Make specific, factual statements.

Use an active, rather than a passive, approach.

Use a consistent, conversational tone.

Avoid redundant statements and filler words.

Write with sufficient detail for the reader to accurately and fully understand

Use shorter, rather than longer, sentences.

e Organize a paragraph to provide a complete unit of thoughts.

PREFERRED, PROPER AND IMPROPER WORD USAGE:

Engineering Description

Preferable Word (or Words)

Approve

Review

Certification (after grading)

Memorandum

Control (the job)

Control tests, compaction tests, give guidance

Or equal Or equivalent
Examination Observation, reviewing, study, evaluate, look over
Inspection Observation, review, study, look over, take density tests

Insure, Ensure or Assure

So that

Investigation (soil)

Exploration, reconnaissance

Necessary, Required, Essential

Considered, advised, study, evaluate, observe, review

Supervise

Observe, review, look over (the job), guide, guidance

SUPERLATIVES OR ABSOLUTES:
Superlatives are words or phrases that include ultimate, absolute conditions. They
should be avoided or used with caution.

Superlatives — Do Not Use

Suggested Alternatives

All

Some, most, usually

At least, all times, all circumstances

All if practicable, sometimes, in most cases

Any When practicable
Best Recommended
Complete (investigation) Scope limited to:
Critical Might or may be

Essential (it is)

Recommended, advised

Extremely, Final, Inevitably, Maximum, Minimum

(Delete or use with caution)

Must, must always, must do, shall Should
Never, no, none, not less than Usually
Obvious Apparent
Possible Practicable
Properly Recommended
Readily May be
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X. CREATION, ADOPTION & USE OF
PROCEDURES

The QA Manager, Senior Staff and Managers shall review and enforce all Procedures in this
Manual, suggest new procedures and improvements to existing procedures that assist in
achieving and maintaining best practices, and encourage other Project personnel to suggest
new procedures and improvements to existing procedures.

Project personnel shall review, understand, and adhere to all Procedures in this Manual, and
may submit suggestions for improvements to existing procedures, or to add new procedures.

The QA Manager will designate a Procedures Committee made up of Senior Staff and
Managers to convene on an annual basis, or as requested by the QA Manager, to review the
contents of this Manual. The Committee will consider and approve/disapprove new procedures
and suggestions to existing procedures at that time.

Once a new or revised procedure is drafted, the QA Manager will designate staff to perform a
Peer Review of the document and attachments. Once the procedure is finalized, the QA
Manager will publish and distribute the new or revised procedure to all personnel who possess a
Manual.

Aside from the annual review, the QA Manager may determine if a procedural change or
addition is appropriate and will be responsible for editing the procedure. The QA Manager may
solicit input, assistance, and peer review from other staff as needed.

All Procedure attachments and forms should be in electronic, editable or “fillable” format when
possible.
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Xl. QA POLICIES & PROCEDURES

1.0|/INSPECTOR DAILY REPORT (IDR)

2.0/ISSUES, DEFICIENCY NOTIFICATIONS, & NCRs

3.0]AIRFIELD PROTOCOLS

4.0]CONTRACTOR QC OBLIGATIONS

5.0|MATERIAL TESTING AND INSPECTION REQUESTS

6.0|LABOR INTERVIEW PROCESS (FORM 1445)

7.0]OFF-HOURS WORK PROTOCOL

8.0|TIME AND MATERIAL (T&M) TRACKING PROCEDURE
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE A

1.1 PURPOSE AND OVERVIEW

This procedure provides direction for documenting the daily construction activities, level of effort,
progress, job site working conditions, quantities and photos. The objective is to create a written
Chronological Record of the construction events, observations and inspections beginning with
time of arrival on site and ending with departure at the end of a shift. Daily reports will serve to
provide necessary information for future use during and following execution of the contract.

The IDR also includes the following procedures, each outlined in this section:

Daily Quantities / Pay Items Procedure
Daily Photo Log Procedure
Field Book Procedure (if applicable)

The DFW QA Inspectors will utilize mobile electronic documentation (iPads or other e-Notebooks)
whenever possible and per project requirements. The Inspector Daily Reports will be produced
utilizing BIM360 platform and later uploaded to Oracle Unifier per DFW requirements. The digital
platform for IDR reporting is project-specific and not necessarily part of the contractual
requirements for the Contractor.

Each QA Inspector is responsible for completing an IDR within 24 hours of each shift completion
and submitting/saving it electronically to the applicable project file/folder in the project’s IDR digital
platform. See IDR in Autodesk BIM360 section below.

Field Books will be used when there is a problem with Mobile Electronic Documentation devices,
digital platform software, or as directed by the QA Manager. The objective is to create a detailed
handwritten account of all construction-related activities observed by the QA Inspector as they
happen, to provide necessary information for future use during the completion of IDRs. See Field
Book section below.

1.2 IDR GUIDELINES AND REQUIREMENTS

Provide a complete story of the day — a detailed account of all activities observed and locations
throughout your time on site. Who was on site? Where were they on site? When were they on
site? What did they do? How did they do it?

Who? Contractor, subcontractors, design consultants, etc.

What? All work activities in progress during time on site

Where? Reference plan sheets, locations and stations, etc.

When? Start time on site, time of key activities, End time

How? Provide a detailed list of Contractor’'s workforce, equipment, materials delivered, and
maintain it consistently on every report.

Record IDR entries in BIM360, and upload to Unifier as required by DFW Document Control. See
Attachment: Autodesk to Unifier instructions.
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1.0

INSPECTOR DAILY REPORT (IDR) PROCEDURE A

IDR should be thorough, concise and accurate. Write in Third person. Document only
the Facts. Do not express opinions, feelings, conjecture or anything personal.

Record the time a project or AOA gate was opened and who was called.

Attach appropriate Photos of the key work activities and locations you are documenting.
Photos are a backup to your documentation, NOT a substitute for documentation, and
they should be referenced in the narrative.

Record and attach Quantities as required. See Daily Quantities / Pay ltems Section
below.

Document Safety conditions on site, status of erosion controls & any Environmental
issues on site

Reference any RFI's & Submittal numbers applicable to work in progress. This includes
validating all materials and equipment delivered to and used on a project meet
Specifications and approved Submittals.

When monitoring Change Directive or T&M work, the When, Who, What, Where and
How are critically important.

Document any tests, observations & inspections performed onsite

Document any Traffic Control in place, including conformance to the number of flaggers,
devices, cones, drums, signs, gate guards etc. required by the approved Traffic Control
or Haul Route Plan.

ANY issues, problems, potential issues should be written in your Daily Report as well as
discussed with your Lead Inspector and PM.

If you create an Issue or Deficiency in the Issue Log, note that you did so and put the
issue title in your Daily Report.

Document Site visitors: ETAM, EAD, Fire, Police etc. (When, Who, What, Where)
Document any Accidents (case numbers) or Near Misses and take pictures. File your
weekly Safety Report.

Document Weather Incidents not automatically recorded by BIM: SMGCS, lightening
alerts, high wind, and tornado’s etc. - record these.

Before submitting, the QA Inspector will compare the IDR with the applicable
Contractor’s Daily Reports, and any/all discrepancies between the two reports should be
resolved prior to submittal.

Write every report as if you will have to defend it in court - everything performed for DFW
is PUBLIC RECORD.

Photos

Concrete Tickets

Plans/Specs

Checklists: Inspection Checklists, FAA checklists, Utility checklists, etc.

SAFETY

Environmental (Weather, Dust, etc.)
Construction/Installation

Special Inspection (Steel, Concrete, Fire Protection)
Operational (Airside closures, traffic control, Haul Routes)
Security
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE

1.3 IDR in AUTODESK BIM360
QA INSPECTOR TRAINING

LI VYV

Each QA Inspector will receive training for using BIM360 to complete their Inspector Daily Report
(IDR). Inspectors will document all aspects of their daily report in BIM360, including photos and
quantities. For final DFW Document Control the Inspector will export the IDR to a pdf and upload

to Unifier.

QA Inspection Daily Report (IDR)

How to create a daily report

N =

Select the QA Daily Inspection Report

Checklists + < Back Templates
. = © Checklist completed

AIR HANDLING UNIT - FUNCTIONAL
uuuuu ew Edit SCRIPT & DATA

5 Tatay Y i ¥
#8 QA Inspect on Daily Report -Drone. B OA InspectionDatly Bepart - Denog
e ;

5 QA Inspection Daily Report
1. Create a Daily 4

9 s s, 20 Report
#7 QA Inspection Daily Report Unspecified

Quantities/Pay Items

Aug 18, 2020 Quality
Note: Be sure
5 you're in the
- correct project

#6 Quar

#5 Quantities/Pay Items test
na Brawn (VRX

#4 Quantities/Pay Ttems
Breanna Brown (VR

HIOAINSPEC’ Fijpers == 71

Bl A B crecuin -3 & oaly Lo : L] A

See Attachment: BIM360 IDR Training Module

AUTODESK BIM360 SUPPORT STAFF

Breanna Brown
972-973-1862
bbrown@dfwairport.com
QA/BIM360 Coordinator

Open BIM360 app on iPad > Select the correct project > Create Daily Report > + (select the plus sign)

2. Select the QA
Inspection Daily
Report

Select and create a new checklist

M™EAAS
L1 ¥YV¥
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE L1 VYV

1.4 ORACLE / UNIFIER RECORD DOCUMENTS
AUTODESK to UNIFIER

Although BIM360 will be utilized for Inspector Daily Reports, the QA Inspectors will be required to
upload their reports to Unifier as DFW’s official Document Control filing system.

Inspection Daily Reports
Autodesk —> Unifier

01. 02. 03. 04.
Autodesk — Unifier — Project (ICP #) tab Details Tab - Document Information Tab —
Complete the QA Inspection Open the Document Submittal 1 Title: IDR xx-xx-xx (date) Aftach the Autodesk record
Daily Report BP and save a BP under the Document Control 2 Description: QA Daily Report PDF & click the Line ltam
PDF. folder Suggested File Location: 08.25 Details “Save” before sending
— e
v;-:---m‘-”n i Pty ORACLE' Primavera Unifisr
B = =1-—
] - =
=
MENAS
I./F Yy

NOTE: With the adoption of the BIM360 digital platform for QA Inspectors, previously utilized IDR
Checklist Forms have been rendered obsolete, but they are included in the Attachments for
reference and could be used if the digital platform is inoperative or shut down.

ORACLE UNIFIER (SKIRE) SUPPORT STAFF

Dana Yates

Program Administration Manager
972-973-1722
dyates@dfwairport.com
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE A

1.5 DAILY QUANTITIES / PAY ITEMS

This section establishes the material inspection process for verifying and documenting progress
quantities for payment, ensuring materials and equipment are tested and/or inspected, and
providing a record document which will support payment of the final quantities.

The QA Inspector completes the IDR with all required backup, as outlined in the previous sections.
The CM Team checks all daily reports for accuracy and neatness, enters all daily quantities in the
Quantity Book (Excel spreadsheet) within one day of completion, and maintains all Quantity Book
entries.

As material is being installed or work is being performed that incorporates materials, each
QA Inspector must provide a concise, accurate daily account of the Contractor’s work so
it may be recorded as part of the project records. A Quantity Checklist is to be created
anytime work is being performed that needs to be recorded for payment.

The Quantity Checklist must be completed by the QA Inspector who performed the
material inspection. Each completed checklist report should be submitted as part of the
QA Inspector Daily Report (IDR) in BIM360.

The Quantity Checklist must include actual (or, when necessary, estimated)
measurements and calculations that substantiate the quantity being paid. In addition to
the Checklist, the QA Inspector must provide sufficient backup documentation. As
applicable, the following documents must be attached:

Calculation Sheets with Yield Checks, if required

Project Photos, if required

Highlighted Drawings, if required

Material Tickets, if required

Upon receipt, the CM will review each Quantity Checklist for accuracy and compliance
with the Contract requirements. If the CM has any questions, they will contact the
appropriate QA Inspector who originated the report for clarification.

Once the CM is satisfied with the Quantity Checklist accuracy and compliance with the
Contract requirements, they will enter the installed quantities into the Project’s Quantity
Book (Excel spreadsheet).

The QA Manager may conduct an independent review of select Quantity reports, to ensure
accuracy and compliance with Contract requirements and with this Manual.
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE A

QUANTITIES / PAY ITEMS in BIM360

How to Create the Quantities/Pay Items Checklist

» Select the "Quantities/Pay ltems” Checklist
» Note: You will see Templates instead of Checklists
» Next, you will see a preview of the checklist
» Atthe top right of the preview, tap “Select’
— Note: « Back Templates Quantities/Pay [tems Select
“Templates" will

appear instead of | LV U O T - FUNCTIONAL
“Checklist” SCRIPT&DATA Overview

5. “Select” Report

QA Inspection Daily Report QA [nspection Daily Report
" 4. Select the Quantities/Pay
ltems Checklist

I
SN N h
/®q -/

an a checklist A preview of the checklist

M™EAAS
L1 VY

See Attachment: BIM360 Quantities/Pay Items Training Module

1.6 DAILY PHOTO LOG PROCEDURE
GENERAL

As part of the Inspector Daily Report (IDR), the QA Inspector will document the progress of each
project daily via digital photography. As work progresses, the project must be photographed to
provide an accurate account of the work. The QA Manager will ensure that each Inspector is
properly equipped with a means to take digital photographs while working.

DAILY PHOTO REQUIREMENTS

QA Inspector Responsibilities

1. Take a minimum of three (3) progress photos for each activity observed that day.

2. In addition to progress photos, also photograph any work or other activity associated with
change order work, claims, potential claims, accidents, incidents, etc.

3. Photos should be of sufficient quantity and composition (angle, distance, etc.) to provide
an accurate account of the work being performed, or the activity or incident being captured.

4. Assign Photos unique filename with Date, Project name, and photo number (example: 08
12 2020 _Runway 18R _photo1.jpg)

5. Upload Photos into appropriate file/folder location within Project's designated digital
platform: Oracle Unifier, BIM360 Field, or other, as designated by the CM Team.

6. Record required information into Daily Photo Log for each photo. Each entry into the log
must contain the following information:
¢ Date of the photo
¢ Location of the photo (as exact as possible)
e Short description of what is depicted in the photo
¢ Name of individual who took the photo
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE A

CM Team Responsibilities
1. Establish consistent, appropriate file/folder structure within Project’s digital platform
(Oracle Unifier, BIM360 Field) for use by QA Inspectors and others to save/upload
documentation, photos, etc.
2. Review uploaded photos and provide feedback to QA Inspector(s) to improve photo
details, frequency, etc. This is intended to improve the overall quality of the project
documentation as the project progresses.

BIM360 PHOTO LOGS

How to Upload Photos to BIM360

AA & docs.b360.autodesk com (5]

B BIM 360
Open in the

BIM 360 app

# Document Management roLoEss ML 1ssuEs
« I - GICIE
Folders ts

{ Photos  All Photos Done Description Version  Size Last updat ed &

ki You will then be
prompted to select

1 I—— the photos you

want to upload

- Project Photos
» 1. August 2020
= [7] 2. September 2020

") Week1(09.01 - 09.05)

I (<]
\
A

B | : b
Week 3 (09.13 - 09.19) ‘\ z b | =

i =
Week 4 (09:20 - 09.30) ) ) This folder fs empty.

‘ag and drop or upload project fles.

» [ 3. October 2020 =
e eee—

Navember 2020

C—
Actual Size (4.7 MB)
Project Specifications Choose Image Size

+ [] Quantities-Pay Items Reference M™IVAT

RFI's

See Attachments: BIM360 Photo Log Training Module and BIM360 Photo Tips
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1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE A

1.7 FIELD BOOK (Handwritten) PROCEDURE

Keep Field Book on site at all times.

Record chronological construction activities observed each day.

Use Field Book for hand drawings and/or sketches pertaining to construction activities and
results of testing.

Field Book should be Hard cover, bound type book

DFW Project Number

The Project Name

Beginning and Ending Dates of Field Book

Inspector’s Full Name printed legibly

Book number, if more than one Field Book is used on a project by an Inspector (example:
FB#1, FB#2, etc.)

Today’s Date

Time of QA Inspector’s entry/egress to the site or AOA

Inspector Name

Ambient Temperature with weather conditions (3 times / shift)

Applicable Drawing or sheet number(s) to the work being observed

Applicable Specification number(s), including page and paragraph references, where
applicable, to the work being observed

Applicable Submittal number, RFI number or other documentation to the work being
observed

Start Time of Contractor’'s Work

Entry/Egress gate(s) or other access point(s) to work site or AOA

Contractor’'s Manpower, to include number of crews, number of personnel in each crew, etc.
Name of Contractor’s Site Superintendent or other Contractor senior on-site representative;
Contractor’s Equipment (Used and Idle)

Work Activities — Describe in detail each construction activity by type, location, craft, and
subcontractor. Location shall include survey stationing and reference to specific structures
Ensure that any T&M work being conducted is tracked accordingly for verification of the
contractor’'s T&M Sheets

Visitor(s) to the work site, including name, company or other entity they represent, and their
purpose on site

Safety-related incidents, including observations and/or “near miss” occurrences

Issues, concerns or problems encountered by the Contractor or others

Finish Time of Contractor's Work

Reference Daily Field Book Entry Checklist. Checklists vary from project to project and must be
tailored to fit each project’s specification.

Inspector Daily Report (IDR) Page 8 of 9 September 2020



1.0 INSPECTOR DAILY REPORT (IDR) PROCEDURE

1.8 ATTACHMENTS

+ BIM360 IDR Training Module

« BIM360 Quantities / Pay Items Training Module

« BIM360 Photo Log Training Module

« BIM360 Daily Photo Tips
IDR Checklist Example Forms (pdf) — Use only as needed
IDR Quantity Example Forms (pdf) — Use only as needed
Daily Photo Log Example Forms — Use only as needed

Field Book Example — Use only as needed

M\IC\AJ
L1 VYYVY
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EA Inspection Dalily
Report (IDR)

In this section you will learn/ review how to
create and export an IDR as a PDF and upload
into Unifier.

M\IC\A/J
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QA Inspection Daily Report (IDR)

How to create a daily report

1. Open BIM360 app on iPad > Select the correct project > Create Daily Report > + (select the plus sign)
2. Select the QA Dally Inspection Report

Checklists o

0000 Project (Training) Template

Q, search by'D, title or location
 Today

#8 QA Inspect on Daily Report -Drone
Breanna Browh (VRX)

97% Completed

[ compLeTED | @ Aug 6, 2020
#7 QA Inspecti i Daily Report
Breanna Brown (VRX)

91% Completed

S Note: Be sure
#6 Quar o

Brean )"OU re In the
— correct project

#5 Quantities/Pay Items test
Breanna Brown (VRX)

— 10% Completed
@ Aug 5,2020

#4 Quantities/Pay Items
Breanna Brown (VRX)
_— 10% Completed

[ 10 PROGRESS 1 Jul 29,2020
#3 QA Inspec’ Fijters == ort
Breanna Brownywrag

n] Documents A Issues

Overview

8 QA Inspection Daily Report -Drone

1. Create a Dalily

Repor‘t Lecation
Unspecified
Schedule Date i
Aug 18, 2020 Quality

Description

1 Daily Report

1.1 Date and Time

August 18, 2020 6:51 AM

Checklists € svnc

@ Daily Logs

@ Checklist completed

Edit

& completed

** More

( Back Templates

AIR HANDLING UNIT - FUNCTIONAL
SCRIPT & DATA

Type: Commissioning

Updated by: Robert Brown [(DFW International...

QA Inspection Daily Report

Type: Quality
Updated by: Breanna Brown (WRX)

Quantities/Pay Items
Type: Quality

Updated by: Breanna Brown [VRX)

.} Documents A Issues

SEPTEMBER 2020

2. Select the QA
Inspection Daily

Report

Select and create a new checklist

Checklists m Syne .‘.‘ Daily Log:

M\IZ\A/J
L1 VYV



QA Inspection Daily Report (IDR)

How to create a daily report

3. Tap select to initiate the checklist
4. “Assign to” checklist to yourself > Select create

< Back Templates QA Inspection Daily Report @

Cancel New Checklist

AIR HANDLING UNIT - FUNCTIONAL Titte*
SCRIPT & DATA Overview e
Type: Commissioning 7 QA Inspection Daily Report
Updated by: Robert Brown (DFW International.. QA lnspecﬁon Da"y Report X ¥e UK 267100
QA Inspection Daily Repart S8sections  [E]35Items  [/17 Instances 1Dail - Assigned to
Type: Quality Breanna Brown (VRX)
Updated by: Breanna Brown (VRX) Type ore

Quality Location
Quantities/Pay Items iy Ité Unspecified
Type: Quality Daserption
Updated by: Breanna Brown (VRX) | Hre: Schedule Date

Unscheduled
1 Daily Report

1.1 Date and Time

‘ Documents A Issues Checklists @ Syne ‘ Daily Logs === More

IN\I\A/
SEPTEMBER 2020 /1 vy



QA Inspection Daily Report (IDR)

How to create a daily report
5. Select “Done” on all sections to change the status to “Completed” > Select “Checklist Completed
> go to BIM360 Safari to export Report as PDF

11

_ Checklists
Q Search by ID, title or location
Overview Edit

. Today
#11 QA Inspection Daily Report

Breanna Brown {VRX]
@ Failed 1o sync checklist :

AT Tt AN RN by fupary 5. Select “Done” by O Compid
 Today i ea;h t
#8 OA Inspection Daily Report -Orone i3 it 4T Se IDH[G anges 0

Bréannd Brown {VRX) 3 alean Ll ﬂﬂmpletef-j} = 5‘3'3Ct

2 ompeiad Checklist competed
08/18/2020 1p

T Aug 6, 2020
#7 QA Inspection Daily Report

Breanna Brown [VRX)
91%: Complated

I PROGHESS | [0 Aug 5, 2020
#6 Quantities/Pay Items test 2

Breanna Brown {VRX)
—_— 10°% Completed

m 0 Aug 5, 2020
#5 Quantities/Pay Items test

Breanna Brown [VRX)
— 10% Completed

@ Aug 5, 2020

Fil =
H4 Quantities; J e =

‘] Documeants a

L

1.2 Project Name

Training Template

Issue

1.3 General Contractor
Checklists m Syne
SEPTEMBER 2020

M\IZ\A/J
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12

QA Inspection Daily Report (IDR)

How to export a daily report as PDF

BIM360 Safari(web version) > Field Management > Select the report

dfwia-unifier.oracleindus

Che klists

) AUTODESK BIM 360

Field Management

1D

10

Templates

Title ~

QA Inspection Daily Report

QA Inspection Daily Report

QA Inspection Daily Report

QA Inspection Daily Report

QA Inspection Daily Report

QA Inspection Daily Report -Drone

QA Inspection Daily Report drone 2

QA Inspection Daily Report - drone I..

Quantities/Pay Items

Quantities/Pay Items test

& field.b360.autodesk.com

ra Unifier

CHECKLISTS

> Go to BIM360 “Safari” (web version)

DFW International Airport > 0000 Project (Training) Template -

BIM 360 Field Management

> Select the correct project

Tes > Select the Walffle(9 dot icon)

N Select Field Management > checklists

QA Inspection ...

QA Inspection ..

QA Inspection ...

QA Inspection ...

QA Inspection ..

QA Inspection ...

QA Inspection ..

Quantities/Pay...

Quantities/Pay...

SEPTEMBER 2020

> Select report

Eric Hernandez

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Signed

2 Pending

Progress

Jul 29

Aug 18 1/1

Jul 29 2/2

Aug 6

Aug 18

Aug 5 -

Aug 5 -

rt Create Checklist

o

M\IZ\A/J

L/

vy



QA Inspection Daily Report (IDR)

How to export a daily report as PDF
Select the Export Icon
AA @ field.b360.autodesk.com

dfwia-unifier.oracleindustry.com/... Primavera Unifier Create New Issue Notice - Project... BIM 360 Field Management

 AUTODESK BIM 360 | DFW International Airport > 0000 Project (Training) Template

@ Generating QA Inspection b4
Daily Report PDF Report.
2 Field Ma nagement CHECKLISTS DAILY LOGS
< #11 QA Inspection Daily Report > h =
" Export as PDF report
. Details ~
1@ @ aa Inspecticp Daily Rgpnrt >
) > select the export icon oy e
1 Daily Report ' _ 5 5op up messages s
p p . p g Assigned To:
. generating the report A —
. ate and lime . .
and Autodesk will email -
cation:
08/18/2020 1p report when ready
Document Issue Note Photo
Scheduled:
Aug 18
1.2 Project Name
Date Started:
Training Template Aug 18
Document Issue Note Photo Completed On:
Aug 19
1.3 General Contractor
Type:
N/A Quality

M\IZ\A/J

13 SEPTEMBER 2020 Descoton /I vy



QA Inspection Dally Report (IDR)

How to export a daily report as PDF

Open Outlook > “Other” Inbox > Open the email from Autodesk > Select Download Report
ss= S ij

= Filter 0000 Project (Training) Template BIM 360 QA Inspection Daily Report

Autodesk BIM 360 R... 12:15PM
0000 Project (Training)
ution: Th il o

@ Autodesk BIM 360 Reports

>0pen Outlook on iPad
> Select “Other” inbox
> Open email from Autodesk
> "“ Download Report”

Project:

N\[C\A/
LI VYV




QA Inspection Dally Report (IDR)

How to export a daily report as PDF

Redirected to a pop-up > select Download > Again, Redirected to Field Management > Download Icon > Select the report from the download icon’s drop down

Q Search or enter website name _ & field.b360.autodesk.com

ra Unifier Cre ce... B |d M ownloads

7 AUTODESK' BIM 360 | DFW International Airport > 0000 Project (Training) Template »

. QA Inspection Daily Report
i Field Management CHECKLISTS ISSUES 168 KB

‘ #11 QA Inspection Daily Report
! Issue #8_ Training issue
-

. Issue #7_Training
1 Daily Report > Select the download e ks

> Select Download

icon
11 Date and Time > Select the report frO!T} BE Breanna Brown
e o the download drop down Location:
Scheduled:
i : . Aug 18
Do you want to download "QA Inspection Dail 5 e :
Report.pdf"? Date Started:
Training Template Aug 18

Completed On:
Aug 19

N\AA/
SEPTEMBER 2020 /I vy



QA Inspection Dally Report (IDR)

How to export a daily report as PDF

>Redirected to the report > select the export icon > Select “Save to Files” on the export drop down > Select “On My iPad” > After selecting the location > Save

QA Inspection Daily Report ' D Note:

‘ _ You can create a folder
tonDaity Report for all QA Daily reports
by selecting the folder

plus

0000 Project (Training) Template

JA Daily Reports” on On My iPad.

Checklist detail spection Daily Report

#11 - QA Inspection Daily Report @ ( _ —

||§J| On My iPad

AirDrop Mail Outlook Teams

> Select the export icon SOy

> “Save to Files”

Status e oyt Print Downloads

Created date Aug 18, 2020 > select “ On My iPad
Sign with DocuSign lectfilo | ti

Scheduled date Aug 18, 2020 ZS0INCLNIEL DRANON
Import to Acrobat = Select“Save

Started date Aug 18, 2020 P °

Type Quality

Add Tags

Description

B QA Daily Reports

IN\I\A/
SEPTEMBER 2020 /1 VvV



01.

Autodesk —
Complete the QA Inspection

Daily Report BP and save a
PDF.

CHECKLEST DATAIL

Qa Inspection Daily Repart

L ey CREATED SCHEBUAED COMPUETED
L
s 13 2000 i 13, 2020 B 10, 35

Quatay
SCTIONS RN 1 CONPORMING __ NOW- ik o8
CONFORNING ANSWERED
s ] ] [ n )

Inspection Daily Reports

Autodesk —> Unifier

02.

Unifier — Project (ICP #) tab
Open the Document Submittal
BP under the Document Control

folder.

ORACLE Primavera Unifier

#  Ccompany Work . DCC DF

2 Skylink ATC Replacement - Home

DFW > DCC > Facilities

A Alerts

Document Submittal

&

Information Record
Number Title

uMail

. Collaboration

Document Control
Documents
Document Submittal

—

Unpublished Documents

03.

Details Tab -

1 Title: IDR xx-xx-xx (date)
2 Description: QA Daily Report
3 Suggested File Location: 08.25

Create New Document Submittal

[ [

G Project 1D Record Humber

CP Project Kame Creator

1™

4 General Document Information

suggestes File Location = )

SEPTEMBER 2020

04.

Document Information Tab —
Attach the Autodesk record
PDF & click the Line Item

Details “Save” before sending

Create New Document Submittal

Line hem Datails

4 Document Infofmation
Name *
Name ~ ® /Lo lhem S

Line lom Simtus

Total: 0

Send Savw

M\IZ\A/J
L/
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QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

& dfwia-unifier.oracleindustry.com

Ed Create New Document Submittal...

Create New Document Submittal Send Save — v

Details Document Information

KA
KM

>Title: IDR(date of report) 4 Mail
>Description: QA Daily Report
ICP Project Name Creator >Suggested file location: 08.25
wrefem - sDocument Information to attach IDR

ICP Project ID Record Number

Title * Cre-..on Date

IDR (08/18/20)
Status

4 General Document Inforination
Enter basic information ¢ <.t the reason for this submission Jf documents.

Description *

QA Daily Report o

Information

No Comments are available.

*

Suggested File Location * (%)
08.25

Attachment Counter

g M\IZ\A/J

1 SEPTEMBER 2020 LT ¥V



QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

& dfwia-unifier.oracleindustry.com

Create New Document Submittal...

Create New Document Submittal Send Save = v

Details Document Information

Add Actic’ View Comments by: gy = 1] Line Item Details R
Name - @ /' Lineltem Status
= 4 Document Information
Name *
Line tem Status ' Browse...

Document Manager...

>In “Document Information”
> Add
> Select the Blue Paperclip(attachment)
> then select “Browse”

Total: 0

=n NIVAS
SEPTEMBER 2020 vy



QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

AA & dfwia-unifier.oracleindustry.com

Take Photo or Video , [x] Upload Files

eticd

MNran an

oy Photo Library

B rowse ) tle Rev. No. Issue Date

File N

Browse > Browse

Advanced Options

File Upload Options
@ Include reference files

Upload from My Computer b

@ Revise automatically if file with same name exists

e

. IN\I\A/
SEPTEMBER 2020 /1 VvV
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QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

QA Inspection Daily
Report -Drone 3

Issue #8_ Training issue

Recents

select report

QA Inspection Daily
Report

Issue #7_Training

Issue #8_ Training issue
2

“

html

3986325

™
L/

\A/J
vy



QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

& dfwia-unifier.oracleindustry.com

B Upload Files

Drag and drop or select files to upload

Browse...
File Name File Size Document Title Rev. No. Issue Date
QA Inspection Daily Report -Drone 3.pdf 236 KB

Make sure it’s the
correct report >
“Upload”

1 item ready to be uploaded (236 KB)
Advanced Options

File Upload Options
@ Include reference files

Upload from My Computer ¥

@ Revise automatically if file with same name exists

. IN\I\A/
SEPTEMBER 2020 /1 VvV



QA Inspection Daily Report (IDR)

How to submit IDR to Unifier

@ dfwia-unifier.oracleindustry.com

El Create New Document Submittal...

Create New Document Submittal Send ave = w

Details Document Information

Add Actions v View Comments by:  ay _ 4 T W Q Line Item Details  Attachments §  Linked Records e

=5
4 Document Information
Name Name *

3 P8 QAnspection Dail.

~ @ . Line ltem Status

OA Inspection Daily Report -Drone 3.pdf
Line Item Status

After uploading the
report > “Save” > your
report is now attached

> “Send”

o =YY,
SEPTEMBER 2020 /1 VvV



BIM360

Quantities/Pay Items Checklists
September 2020

Robert Brown
Breanna Brown

DEW



How to Create the Quantities/Pay Items Checklist

_ Checklists +

0000 Project (Training) Template

Q, Search by ID, title or l¢sation

#14 QA Inspection Daily Report

Robert Brown (DFW International \irport)
0% C

». Breanna Brown (VRX)
—_— 20% Completed

 Aug 20, 2020
#12 QA Inspection Daily Report -Training

Breanna Brown (VRX)
91% Completed

@ Aug 18, 2020
#11 QA Inspection Daily Report
Breanna Brown (VRX)

94% Completed

@ Aug 25, 2020

#10 QA Inspection Daily Report drone 2
Breanna Brown (VRX)

97% Completed

#9 QA Inspection Daily Report -
drone 10C Filters =
Unassigned

l
.} Documents A Issues

2. Make sure
© Auc .

#13 QA Inspection Daily Report - YOU’I’e n the

8/24 central tower correct pl’OjeCt

3. Select the plus

sign to initiate a
checklist

Select and run a checklist

1. Select checklist

Checklists @ Sync ‘ Daily Logs

SEPTEMBER 2020

» Select “Checklist” at the bottom

» Be sure you are in the correct
project

» Select the plus sign to initiate a
checklist

M\IC\A/J
LJ1I VYV



How to Create the Quantities/Pay Items Checklist

» Select the “Quantities/Pay Items” Checklist

> Note: You will see Templates instead of Checklists
> Next, you will see a preview of the checklist

> At the top right of the preview, tap “Select”

< Back Templates Note: ¢ Back

Templates Quantities/Pay Items Select

AIR HANDLING UNIT - FUNCTIONAL

AIR HANDLING UNIT - FUNCTIONAL
SCRIPT & DATA

SCRIPT & DATA Overview
Type: Commissioning Type: Commissioning
Updated by: Robert Brown (DFW International.. Updated by: Robert Brown (DFW International.. Quan(ities/Pay Items 5 “Select" Heport
QA Inspection Daily Report QA Inspection Daily Report 1Sections 10 [tems 11nstances
ety 4. Select the Quantities/Pay Type: Quality
Updated by: Breanna Brown [VRX) = Updated by: Breanna Brown (VRX)
Items Checklist Quality
Quantities/Pay Items Quantities/Pay Items
Type: Quality Type: Quality
Updated by: Breanna Brown (VRX) Updated by: Breanna Brown (VRX) Quantities/Pay Items
Select and run a checklist A preview of the checklist

1 Pay Item Descriptions

Bid Item - Description - Quantity - Comments

1.1 Quantity #1

H] Documents A lssues Checklists @ Sync .‘ Daily Logs .] Documents A lssues Checklists m Sync & Daily Logs s+ More

INI\A/
SEPTEMBER 2020 /1 VvV



How to Create the Quantities/Pay Items Checklist

Cancel New Checklist

Title *

| Quantities/Pay Items 09/09/2020_B.Brown ‘

Assigned to
Robert Brown (DFW International Airport)

39/100

Add to the title with your name
and date

“Assign To” CM or CC
Schedule the date

Select “Create”

Location
Unspecified

Schedule Date
Sep 9, 2020

VVV V¥V

INI\A/
SEPTEMBER 2020 /1 vy



How to Create the Quantities/Pay Items Checklist

Checklists s

0000 Preject (Training) Template

Q Search by ID, title or location

IN PROGRESS _ U Today
#15 Quantities/Pay Items 9/8/2020_BB

Breanna Brown (VRX)
— 10% Completed

L i aRTED ]

#14 QA Inspection Daily Report

= Riubert Brown (DFW International Airport)
0% Completed

I Select the checklist
¥ and begin enterin
8/z it s g

. the Quantity/Pay
— Item information
@ Aug 20, 2020
#12 QA Inspection Daily Report -Training

Breanna Brown (VRX)

91% Completed

[ compiereo J @ Aug 18, 2020
#11 QA Inspection Daily Report

== Breanna Brown (VRX)

94% Completed

© Aug 25,2020
#10 QA Inspection Daily Report drone 2

. Breanna Bro'  Filters =
97% Completed

u
.] Documents A Issues

o
=4

1 Pay Item Descriptions

Bid Ttem - Description - Quantity - Comments

1.1 Quantity #1

Bid Item - Description - Guantity - Comments

Bid Item - Description - Quantity 35.75 sq- Comments

Issue — Note

(Optional)
1.2 Quantity #2

Bid Item - Description - Quantity - Comments

Tap to add text

% Issue & Note

{Cptional)
1.3 Quantitv #3

Checklists €D sinc

0/1 Completed  0/2 Signed

- o NN

After entering the
information select “Done”
and it will change to

“Completed”
(=] Photo
=} Photo
& Daily Logs *s* More

SEPTEMBER 2020

Select the checklist and begin
entering the Quantity/Pay Item
information

After entering the information
select “Done” and it will change
from Done to “Completed”

M\IC\A/J
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How to Create the Quantities/Pay Item Checklist

» After selecting “Done”, you will then see a
pop-up window that will allow you to add
signatures to complete the checklist.

All sections completed

All sections have been completed.

m PE N R A . .. i = 2 .. “ . ”
D ool e . > Select “Show Signatures

Show signatures

INI\AJ
SEPTEMBER 2020 /1 V¥



How to Create the Quantities/Pay Item Checklist

— Checklists D
- 0000 Project (Training) Template EI 1/1 Completed 0/2 Signed

Q Search by ID, title or location
Required signatures o/2

Required by

Tod .
s Contractor Representative

#15 Quantities/Pay Items 9/8/2020_BB

» The first signature is required by the

Name Company
. x ¥ «d .
The first signature is Unspecified Unspecified Contractor Representative

@ "Required by” the > Please enter their Name,

H1e Contractor Fie oo C dh th .
Representative. Enter ompany and have them sign
their name, company .

& then have themsign o W . : .

#13 UA Inspection Lally Keport - drone » The second signature is required by

8/284 centrzl tow;a:ﬁx) the QA Inspector/OAR

—— 20% Completed » Please enter your Name, your

Signature 2 .
T Company and sign
H1: ~ g .
The second signature Requited by
— is“Required by"the = QA Tnspecton 0AR
QA Inspector/OAR.
[ ca 1 MName Company
g ENter your name, your - _
1 company then YOU Sign Unspecified Unspecified
—— S reowptehd
Tap to sign
@ Aug 25, 2020
#10 QA Inspection Daily Report drone 2 .
Breanna Bro'  Filters '__Z -\Q’
97% Completed
Documents lssues B4 Checklists Sync B Daily Logs v+ Mare
=1 A | S @
M\ A/
L/ vy

SEPTEMBER 2020



Checklists =1

0000 Project (Training) Template

Q, Search by 1D, title or location

1IN PROGRESS U Today
#15 Quantities/Pay Items 9/8/2020_BB
Breanna Brown (VRX)
— 10% Completed

#14 QA Inspection Daily Report
Robert Brown (DFW International Airport)
0% Completed

IN PROGRESS
#13 QA Inspection Daily Report - drone
8/24 central tower

Breanna Brown (VRX)

& Aug 24, 2020

— 20% Completed
@ Aug 20,2020

#12 QA Inspection Daily Report -Training
Breanna Brown [VRX)

91% Completed

@ Aug 18, 2020
#11 QA Inspection Daily Report

Breanna Brown [VRX)
94% Completed

@ Aug 25,2020
#10 QA Inspection Daily Report drone 2

Breanna Bra'  Fjlters —=

97% Completed

‘] Documents

How to Create the Quantities/Pay Item Checklist

» After both names, companies and signatures are entered, select “Checklist completed”

= 11 Completed  2/2 Signed [RETRAERTTIHET] =5

Checklists =1

0000 Project (Training) Template

A ssues

Required signatures

Signature 1

Required by: Contractor Representative

@  signed by contractor’s name from Contractor's Company on Tue, Sep 08 at 7:22 AM

After both required

Q, Search by 1D, title or location

—

[ compieren ]  Today

#15 Quantities/Pay Items 9/8/2020_BB
Breanna Brown (VRX)

— 10% Completed

#14 QA Inspection Daily Report
Robert Brown (DFW International Airport)
0% Completed

IN PROGRESS
#13 QA Inspection Daily Report - drone
8/24 central tower

Breanna Brown (VRX)

& Aug 24, 2020

B — 20% Completed
signatures have been
St 2 signed, select “Checklist e
" #12 QA Inspection Daily Report -Training
Required by: QA Inspector/ OAR Completw Breanna Brown [VRX)
91% Completed
1T Aug 18, 2020

° Signed by Breanna Brown from VRX on Tue, Sep 08 at 7:23 AM

Checkiists €D svnc & Daily Logs

#11 QA Inspection Daily Report
Breanna Brown [VRX)
@ 94% Completed

@ Aug 25, 2020
#10 QA Inspection Daily Report drone 2
Breanna Bro'  Filters E

97% Completed

*** More ‘] Documents

SEPTEMBER 2020

1t
==

@ Checklist completed

A ssues

Required signatures

Signature 1

2f2

Checklist is now

complete and ready to

Required by: Contractor Representative

initiate the pdf export

@ signed by contractor's name from Contractor’s Company on Tue, Sep 08 a1 7:22 AM

Signature 2

Required by: QA Inspector/ OAR

° Signed by Breanna Brown from VRX on Tue, Sep 08 at 7:23 AM

Checkiists €D svnc & Daily Logs

*** More

M\IC\A/J
LJ1I VYV



How to Create the Quantities/Pay Item Checklist

Note:
Making any changes, after the checklist has been completed, will delete both signatures.

‘Checklist is signed
This checklist contains signatures.
Making changes to the checklist is only
possible after deleting all signatures.

Show signatures

Cancel

INI\A/
SEPTEMBER 2020 /1 vy



How to Export the Quantities/Pay Item Checklist

FDESK BIM 360 || DFW International A

& field.b360.autodesk.com

CHECKLISTS

Checklists Templates

> Open Safari (internet browser for
iPad)
> Select the correct project
= Tap Novi-con(9 dots) select “Field
Management”

> Select “Checklist” next to Field s test
management

> Select the Quantity/Pay ltem

Checklist you want to export Rieste
| 4 Quantities/Pay Items
| 15 Quantities/Pay Items 9/8/2020_BB
| 1 QA Inspection Daily Report
| 2 QA Inspection Daily Report

3 QA Inspection Daily Report

| 7 QA Inspection Daily Report
| 8 QA Inspection Daily Report -Drone
| 9 QA Inspection Daily Report - drone L.
| 10 QA Inspection Daily Report drone 2
i

10

Template

Quantities/Pay...

Quantities/Pay...

Quantities/Pay...

Quantities/Pay...

QA Inspection ..

QA Inspection ..

QA Inspection ..

QA Inspection ...

QA Inspection ...

QA Inspection ..

QA Inspection ...

oject (Training) Template -

Type

Quality

Quality

Quality

Quality

Quality

Quality

Quality

Quality

Quality

Quality

Quality

Assigned to

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Tony Keefer

Eric Hernandez

Breanna Brown

Breanna Brown

Breanna Brown

Breanna Brown

Export Report Create Checklist

Company Signatures ~  Scheduled £
VRX 2 Pending Aug 5

VRX 2 Pending Aug &

VRX Signed Aug 5

VRX Signed Today

DFW Internation.. Jul 29

DFW Internation... Jul 29

VRX Jul 29

VRX Aug 6

VRX Aug 18

VRX Aug 25 ..9

SEPTEMBER 2020

Open Safari (internet browser for
iPad)

Select the correct project

Tap the Novi-Con (9 dots) select
“Field Management”

Select “Checklists” next to Field
Management

Next, Select the Quantity/Pay Items
Checklist you want to export

M\IC\A/J
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How to Export the Quantities/Pay Item Checklist

@ field.b360.autodesk.com

? AUTODESK BIM 360° | DFW International Airport » 0000 Project (Training) Template =

@ Field Management

CHECKLISTS

DAILY LOGS

< #15 Quantities/Pay Items 9/8/2020_BB

I

10

1 Pay Item Descriptions
icon to generate an
emailed pdf report

Bid Item - Description - Quantity - Comments
1.1 Quantity #1

Bid Item - Description - Quantity - Comments
Bid Item - Description - Quantity 35.75 sqg- Comments

Document Issue Note Photo
1.2  Quantity #2 (Optional)

Bid Item - Description - Quantity - Comments

Document Issue Note Photo

1.3  Quantity #3 (Optional)

Bid Item - Description - Quantity - Comments

Required signatures

11

e © M

+ O

Next, select the export @ oone

© Generating Quantities/Pay X

Items 9/8/2020_BB PDF
Report.
Ou s
Potins %
© Quantities/Pay Items w

9/8/2020_BB PDF report will
be emailed to you when ready.

BE  Breanna Brown

Location:

Scheduled:
Sep 8

Date Started:
Sep 8

Completed On:
Sep 8

Type:

Quality

Description:

Quantities/Pay [tems

Linked Documents

No Linked Documents

Linked Asset

SEPTEMBER 2020

- Add Documents

Add refeee

Next, select the export icon to
generate emailed pdf. You will then
receive 2 pop ups.
» “Generating (Checklist name)
PDF Report”
» “(Checklist name) PDF report
will be emailed to you when
ready.”

M\IC\A/J
LJ1I VYV



How to Export the Quantities/Pay Item Checklist

= Inbox 7 e W B
Focused = Other = Filter 0000 Project (Training) Template - Your report is ready
> Open Outlook i
i @ T T .. >Select email with _ | > E)pen (”)utlook
0000 Project (Training) Template... the report > Other” Inbox
gjtl‘;l_'gg:;giV‘fu,m;'r'pff'gagiitc > Select DO\ﬂmload - 0000 Project (Training) Template » Select the email with the report
- Hispon > Next, Select “Download Report”
Project: 0000 Project (Training) Template
Report Title: Quantities/Pay Items 9/8/2020_BB

Download report

B Autopesk gim 360

Add Autodesk BIM 360 to your address book lo ensure you receive emails.
For more information, visit Autodesk BIM 360 Help.

Copyright © 2020 Autodesk BIM 360. All Rights Reserved

4~ v Reply

[ (
Jo

INI\A/
SEPTEMBER 2020 /1 VvV
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How to Export the Quantities/Pay Item Checklist

» Select “Download”
» Then you will be redirected to the checklist, look to the top next to the address bar for the download icon
» Select the report in the downloads drop down

Q Search or enter website name (11 ' aA & field.b360.autodesk.com 2 Ol h + O

360 Field Management (%] Favorites

JDESK' BIM 360 DFW International Airport

el_d Ma nage['nent CHECKLISTS DAILY LOGS ‘

Downloads Clear

' Quantities_Pay Items 9.8_2...

#15 Quantities/Pay Items 9/8/2020_BB 105 KB Q
Q, Find items and section Details e
> Select the download icon S 1/1section [ 1/10 Items
. i 1 Pay Item Descriptions > In the downloads drop @ oone
Select "Downloa _ B down, select the report Assigned o
Bid Item - Description - Quantity - Comments L —
s 1.1 Quantity #1 Location:
Do you want to download "Quantities_Pay Items _ Unspecified #
9.8 2020 BB.pdf"? Description: _
Bid Item - Description - Quantity - Comments Scheduled:
DOW“|03d Bid Item - Description - Quantity 35.75 sq- Comments Sep8
| Document £ Issue £l Note =] Photo [:ate:tarled;
M\ICTAA/

SEPTEMBER 2020 /1 vy



How to Export the Quantities/Pay Item Checklist

Done Quantities_Pay Items 9_8 2020_BB 3 0 [ﬁ

o Quantities_Pay Items 9.8 2020 BB 3
0000 Project (Training) Template PDF Document

Checklist detail

#15 - Quantities/Pay Items 9/8/2020_BB @ g [I I

» The report will open, Select

AirDrop Mail Notes Outlook
the Export Icon on the to
> Select the export right P P
icon Copy @ " H ”
s Selact “Save to » Then select “Save to Files
: Files” - .
Status | Completed FRAt @
Created date Sep 08, 2020 Save to Files B85
Scheduled date Sep 08, 2020 Add Tags C
Started date Sep 08, 2020
Import to Acrobat }c.
Completed date Sep 08, 2020
Edit Actions...
Type Quality
Description Quantities/Pay Items

INI\A/
SEPTEMBER 2020 /1 VvV
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How to Export the Quantities/Pay Item Checklist

Item will be saved to “"Downloads” on On My iPad.

~ Quantities_Pay tems 9.8 2020_BB 3

M iCloud DN

i On My iPad

‘B Acrobat

F4  GarageBand for i0S
‘m iMovie

- Keynote

{0 Numbers

| Pages

& ProKnockout

SEPTEMBER 2020

YV VvV

vV VYV

The report will open

Select the Export Icon on the
top right

Then select “Save to Files”
File Location (example
shows Downloads)

Next, select “Save”

Note: You can change the

file location by selecting the

Folder Icon(next to Save) on

the top right

» Name a folder for all

IDR’s, Issue notices,
Quantities/Pay ltems,
etc.

M\IC\A/J
L1 VYV



How to Export the Quantities/Pay Item Checklist

Browse @)  <onMyiPad Downloads Select

Locations ) 2 ¢
“ iCloud Drive
D On My iPad
*=* More Locations 9 — I = T — - > View the re port on the iPad
= contl Deleted | —_—) = > Open the “Files App”
Recently Deleted QA Inspection Daily Quantities_Pay Items QA Inspection Daily p « pp

Report 9.8 2020_BB 9.8.2020_BB 3 Report » Select on my “On My
Favorites Tcda;jii:é‘. PM .Uda'l,; g:}?{g‘l AM Sep1, 20222'{):3‘3&‘;0:34 Al IPad”

» Then select the file
- Downloads .
location
- Downloads
Tags
® Red
@ Orange
Yellow
@® Green
@® Blue
® Purple 3 items, 92.34 GB available
o Recents i Browse
M\ A/
L/ vy

SEPTEMBER 2020



How to Upload the Quantities/Pay Item Checklist

< 1] »A & docs.b360.autodesk.com e © M + O
ODESK BIM 36 DFW International Airport > 0000 Project (Training) Template ~

. Document Ma nagem ent FOLDERS REVIEWS TRANSMITTALS ISSUES

View by ol Upload files H Showing 1 item Y I =3
Folders Sets
: (] Name~ Description Version Size Last updated | ¥
¥ Plans ] =) Quantities_Pay Items 9_8_2020_BB 3.pdf %1 102.4 KB Sep 9, 2020 7:41 AM
T
~ @]} Project Files ]
E : > Open Safari
[] DCN Summary > Be sure the correct project is selected
_ > Select the Novicon(9 dots) go to Document Management
W FroleckEbotss > Select drop down arrow next to “Project Files”

> Next, Select the “Quantities-Pay ltems Reference
> After that, select the “Quantities-Pay Items Checklists”
+ [] Quantities-Pay Items Reference > Select “Upload files”

[ Project Specifications

[ ] Quantity-Pay Item Checkliksts ses
[ RFI's
[7] Submittials

[ ] videos

M\IC\A/J

SEPTEMBER 2020 L1 vy



How to Upload the Quantities/Pay Item Checklist

AA @ docs.b360.autodesk.com ) )

) AUTODESK BIM 360 \ DFW International Airport > 0000 Project (Training) Template ~

3 Document Management FOLDERS REVIEWS TRANSMITTALS ISSUES
View by = IEH IS .00 0, seaietifardo B S

Folders Sets Take Photo or Video iz
y scription Version Size Last updated | £
Photo Library [i
[E_T‘\‘J pPlans V1 102.4 KB Sep 9, 2020 7:41 AM
v 1) Project Files Browse i
] DCN Summary
"] Project Photos After Selecting
["] Project Specifications “Upload Files” you
« [] Quantities-Pay Items Reference will then see a drOp
down
[ ] Quantity-Pay Item Checkliksts «ss > Select “Browse”
[] RFI's
] Submittials
] Videos

M\IC\A/J

SEPTEMBER 2020 L1 vy



How to Upload the Quantities/Pay Item Checklist

Cancel

Q. Search 9

Quantities_Pay Items
98 2020 BB 3

Today at 1:54 PM
On My iPad

W,
[ Erowse

INI\A/
SEPTEMBER 2020 /1 vy



How to Upload the Quantities/Pay Item Checklist

< [I] AA

& docs.b360.autodesk.com

3 AUTO . BIM 360 DFW International Airport » 0000 Project (Training) Template «

i Document Management FOLDERS REVIEWS

View by

[EY Plans

= )] Project Files
| ] DCN Summary
["] Project Photos

[77] Project Specifications

= [ 7] Quantities-Pay Items Reference

[[7] Quantity-Pay Item Checkliksts «ss
[ RFI's
[T Submittials
[7] Videos

20

Upload files

Name A Description

= Quantities_Pay Items 9_8_2020_BB 3.pdf

> After selecting the report, you
will then see the report start
processing the upload at the
bottom right

> Once the report is done
processing, you will see that it
was uploaded in the
“Quantities_Pay Items Checklist”
Folder

SEPTEMBER 2020

It (] L
Version Size Last updated o
vi 102.4 KB Sep 9, 2020 7:41 AM
Process v X

Processing 1 file.

Quantities_Pay Items 9_8_2020_BB 3.pdf

Pending processing..

M\IC\A/J
LJ1I VYV



How to Upload the Quantities/Pay Item Checklist

The Quantities/Pay Items Checklist has been uploaded to BIM360 and available for the CC/CM to view.

< m B & docs b360.autodesk.com ¢ © (O +

) AUTODESK BIM 360° | DFW International Airport » 0000 Project (Training) Template «

# Document Management FOLDERS REVIEWS TRANSMITTALS
Wiow by Gt Upload files ' Showing 1 item Q i <[y
Folders Sets
| Namea Description Version Size Last updated e

% Plans ~| [2) quantities_Pay Items 9_8_2020_BB 3.pdf v2 1024KB  Sep 9, 2020 1:55 PM

~ @1 Project Files
[7] DCN Summary
|| Project Photos
[77] Project Specifications
= [] Quantities-Pay Items Reference
1_ Quantity-Pay Item Checkliksts sss
[] RFI's

771 Submittials

| ] Videos

M\IC\A/J

SEPTEMBER 2020 /1 VvV



BIM360

Photo Presentation
September 2020

Robert Brown
Breanna Brown

DEW



How to Upload Photos to BIM360

< M aA & docs.b360.autodesk.com ¢l @ Oy +

FOLDERS

View by Upload files - 1) i @

Name ~ Description Version Size Last updated el

5l Plans

[c*

> Go to Safari
> Be sure you're in the correct project

]
=)

71! Project Files

[ DCN Summary > Select the Novicon(9 dots) then “Document
o Management”
- Froject Fhotos > First, select "Project Files”
» [ 1. August 2020 > Next, select “Project Photos”
= Then, select the week the photo was taken

v [ ] 2 September 2020 > Select “Upload Files”

] Week 1(09.01 - 09.05) l'

f Week 2 (09.06 - 09.12)

"] Week 3 (09.13 - 09.19) =

[~ ] Week 4 (09.20 - 09.30) This folder is empty.
» [ 3. October 2020 Drag and drop or upload project files.
» [] 4. November 2020

Upload

» [7] 5. December 2020

[77] Project Specifications

» [ ] Quantities-Pay Items Reference
[1 RFI's

Submittials

Learn more about uploading documents, 9 n ‘ A I
SEPTEMBER 2020 vy

[ Videos



How to Upload Photos to BIM360

AA & docs.b360.autodesk.com ¢ ©

B BIM 360

DREb e EIMLRE Take Photo or Video (O]

BIM 360" | DFW Intern:

Photo Library E
: Document Manad

Browse see

= N G B |G
a Description Version Size Last updated o

|| Namea~
[ Plans
= i) Project Files
] DCN Summary Select “Photo Library”

= | ] Project Photos

» [ 1. August 2020

» [ ] 2. September 2020 @
7] Week 1(09.01 - 09.05) 4»

7] Week 2 (09.06 - 09.12)

] Week 3 (09.13 - 09.19)

[[7] Week 4 (09.20 - 09.30) This folder is empty.

» [] 3. October 2020 Drag and drop or upload project files.

¥ [[] 4 November 2020
Upload

» | ] 5. December 2020

["] Project Specifications

» | ] Quantities-Pay Items Reference

o N\ITVA/

7] Submittials SEPTEMBER 2020 U V V



How to Upload Photos to BIM360

AA & docs.b360.autodesk.com S ©

B BIM 360 -
Open in the BIM 360 app

) AUTODESK BIM 360 | DFW International Airport » 0000 Project (Training) Template »

# Document Management FOLDERS

View by oo Upload files . I 0

[ Plans ' sy o = ol —

( Photos All Photos Done Description Version Size Last updated o2

= @1 Project Files

You will then be

_ prompted to select
~ [Z] Project Photos P e the photos you

| = R »
» [ 1. August 2020

- _ B want to upload
~ [[] 2. September 2020 | ‘ @
["] Week 1(09.01 - 09.05) . . (/]

[ Week 2 (09.06 - 09.12)

|1 DCN Summary

[*] Week 3 (09.13 - 09.19)

F B

' B 5 -

[*] Week 4 (09.20 - 09.30) l () l ‘ (V) This folder is empty.
L J -

» [7] 3. October 2020 'ag and drop or upload project files.

» [ 4. November 2020 ! = |
S Upload
» [] 5. December 2020 i
Actual Size (4.7 MB)
7] Project Specifications Choose Image Size
» [T Quantities-Pay Items Reference ™ \A/J

e SEPTEMBER 2020 L1 vy



How to Upload Photos to BIM360

< M AA @ docs.b360.autodesk.com e ©) lﬁ e

) AUTODESK BIM 360 | DFW International Airport » 0000 Pro (Training) Template

2 Document Management FOLDERS REVIEWS

T ® 8o

[©8l Plans L] B235DED3-3442-48B7-B41C-A488B22E8CIE.... V1 15MB Sep 10, 2020 8:16 ..

| Name~ Description Version Size Last updated o

¥ [ Project Files DABAD6BC-B119-4DA9-9E0D-F5DEBES vi 1.5 MB Sep 10, 2020 8:16 ...
] DCN Summary > Move Photos have
s Photo #1.jpe Vi 8
= [*] Project Photos & phg [ copy been processed
» [ 1 August 2020 Nats! # Ranstie and uploaded
Lock
- |‘_‘ | 2 September 2020 TO Change IhE‘ name & o
: > select the 3 dots next to the < Share
“7] Week 1(09.01 - 09.05
=l ( name T Delete
Week 2 (09.06 - 09.12 ERial=]aMN R (=Iat=l0al=0 ; ,
Bl e G [# edit set assignment Process MK
[[] Week 3 (0913 - 09.19) @4 Edit attribute values
< 3 uploaded.
[] Week 4 (09.20 - 09.30) View file activities
» [7] 3. October 2020 EL Download source file B235DE03-3442-48B7-B41C-A488B22E...
» [ 4 November 2020 [F submit for review @ uploaded

- D E Create transmittal
» [7] 5. December 2020 DABAD68C-B119-4DA9-9E0D-F5DFBEG...

["] Project Specifications (v

Uploaded

» [7] Quantities-Pay Items Reference
34E394FD-0347-4896-B3F1-18C74006..
[ RFr's

771 Submittials n ‘ A l
SEPTEMBER 2020 /1 VvV



How to Upload Photos to BIM360

< MAREY. & docs.b360.autodesk.com ¢ ©® M +
B BM360 P

Open in the BIM 360 app

Y AUTODESK BIM 360 | DFW International Airport

# Document Management FOLDERS REVIEWS TRANSMITTALS
T S)alfs
o | Name A Description Version Size Last updated 3
5 Plans ﬁ Photo #1.jpeg V1 15MB Sep 10, 2020 8:42 ...
v [ Project Files ] [ Photo#z.jpeg Vi 15 MB Sep 10, 2020 8:43 ..

[] DCN Summary
[E] Photo #3.jpeg Vi 1.5 MB Sep 10, 2020 8:44 ..

g Project Photos

» [7] 1 August 2020

Photos have been uploaded,
renamed and filed properly

~ [7] 2. September 2020
["] Week 1(09.01 - 09.05)

7] wWeek 3 (09.13 - 09.19)

[ Week 4 (09.20 - 09.30)

» [] 5. December 2020

[77] Project Specifications

» [ ] Quantities-Pay Items Reference r\ ‘ A l
SEPTEMBER 2020 vy



Daily Photos
Mark Up Photos

__|
Close IMG_1d8¢2410-9dcd-46af-a43b-ebbba9027f23.jpg E m

e Always mark-up photos
calling out what is being
done in the photo.

e A picture is only worth a
thousand words if you
know what the picture is
of.

" = \ .
el B
0112,' 08:31 ’

]

INI\A/
SEPTEMBER 2020 L1 vy



Daily Photos
Good Reports

Examples...

 Addresses the Who, What, Where, When,
and How.

* Written in third-person.

2020-01-09 15:43:16 2020-01-09 13:23:59 .
+ States the facts as you would in court.

* Photos attached with markup graphics and
short worded description on it.

 References documents.

2020-01-09 11:58:50 2020-01-09 11:36:36

INI\A/
SEPTEMBER 2020 /1 VvV
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DFW Airport System
Inspector Daily Checklists
Project: (1)
Specification Section: (2) Date: (4)
Responsible Contractor: (3) ' Da ' Night
Item # Description QC Conformance
5) | ®) " Yes ' No
Deficiency #___ (7)
(If Applicable)
NCR# _ (8)
(If Applicable)
Location: (9)
Yes No N/A  Checklist Item
! ! ! Approved Submittal
! ' ! Proper Storage of Material
! ' ! (10)
Comments: (11)
(12)

Construction Quality Inspector

Checklist Example

February 2020



Checklist Form Directions

I\[\A/

L1

*Reference numbers on the preceding Procedure Review Form marked "Example". Follow the completion directions below.

vy

Number Title: Directions
1 Project Type the project name
2 Specification Section Type the applicable Specifications Section
3 Responsible Contractor Input the Responsible Contractor. Ifitis a Subcontractor, list them as well.
Input the date that the Checklist was performed. Use format month.day.year (i.e. 09.13.2018) Circle
4 Date "Day" or "Night" for what time the work was performed.
5 Item # Input the Line Item # for the applicable Checklist
6 Description Write the Line ltem Description exactly as it appears on the plans
If the work was completed in conformance with the Specifications, circle "Yes" otherwise circle "No".
7 Deficiency # If there is Deficiency, write the Deficiency report number
8 NCR # If there is a NCR issued for the work, write the NCR number in this space. If not, write "N/A"
Write the location of the work. Use concise language that can be followed. Use landmarks, stations
9 Location and offsets, etc.
10 Checklist ltem In these spaces, write all of the applicable specification requirements for the Checklist item.
11 Comments Write any comments that you have that have not been covered by other parts of the form.
12 Construction Quality Inspector Signature of the Inspector performing the Checklist.

Checklist Directions

February 2020



IN\[\A/J
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DFW Airport System
Inspector Daily Checklists
Project:
Specification Section: CSI 3300/ Cast-In-Place Concrete Date:
Responsible Contractor: ' Day ' Night
ltem# Description QC Conformance
" Yes ' No
Deficiency #

(If Applicable)

NCR #

(If Applicable)

Location:
Yes No N/A Checklist ltem
! ! ' Approved Submittal
! ! ' Proper Storage of Material
! ! ! Descending air temp. >40F. Resume @ ascending air temp. 35F, or per cold weather plan
! ! ' Hot weather precautions @ >85F air temp. Concrete temp. 50 - 95F
! ! ' All rebar & embedded items properly fastened and in correct position. (Sleeves, conduits, etc.)
! ! ! Check forms for dimensions, line, grade and plumb. Clean forms given a coat of form oil
! ! ' No vertical drop for concrete >5.0'. Use chutes or tremies for vertical drop >5.0'
! ' ' Do not deposit concrete on wet, muddy or frozen subgrade
! ! ' Provide proper waterstop for construction joint at approved location
! ! ' Haul time: 90 min. agitated trucks, 30 min. non-agitated trucks
! ! ' Make one set of 4 cylinders per pour or 100 CY. 2 @ 7days, 2 @ 28days, 4000PS| @ 28days
! ! ' Slump 2-4" for footings/walls, 2.5 - 3.5" for all else, or per mix design. 2 tests/pour & with cyl.
! ' ' Air content 4-7% or per mix design. 1 test/50 CY and with cylinders. Test first load
! ' ' Vibrate concrete, float and finish per Spec.
b ! ! Cure concrete per Spec. Patch form tie holes and honeycomb with mortar per Spec.
Comments:

Construction Quality Inspector

Checklist Sample

February 2020



Specification Section:

IN[\A/J

Responsible Contractor:

Iltem # Description

L1 VY
DFW Airport System
Inspector Daily Checklists
Date:
' Day ' Night
QC Conformance
" Yes ' No
Deficiency #

Location:

(If Applicable)

NCR #
(If Applicable)

Yes No N/A Checklist Iltem

' ' '
! ' !
! ' !

! ' !

Comments:

Approved Submittal
Proper Storage of Material

Construction Quality Inspector

Checklist Blank

February 2020
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L1 V¥
DFW Airport System
Inspector's Daily Report for Quantity Book IDR# ()
Contract Day No: (1) Shift: (2)
DFW Project No. (3) Date: (4)
Project Name: (5)
Contractor: (6)
Weather: (7)
Hours Worked: (8)
Item Code . Quantity & Evidence of Material Quant.
No. Item Location Units Inspection Bk.
(10) (11) (12) (13) (14)
)
Calculations and/or sketches: (15)
(16)
Verified and agreed to by:
This is: |:| Estimated progress measurement (Item no.: ) (17)
|:| Final field measurement (Item no.: ) (18)
Remarks: (e.g., instructions to Contractor, special problems, sketches with dimensions for final measurements, computations, number of persons
working, hours worked). Use reverse side, if needed. See attached backup, (maps, sketches reports, etc.) Pgs. Total. (1 9)
Initials Date
Inspected by: (20)
Measured by: (21)
Calculated by: (22)
Checked by: (23) (24)
Construction Manager
February 2020

IDRQ Example



Inspector’s Daily Report Form Directions

IN\I—\A/
L/ VY

*Reference numbers on the preceding Procedure Review Form marked "Example”. Follow the completion directions below.

Number Title: Directions

0 IDR # The number should be the Line Iltem # followed by the numeric order for the item of work

1 Contract Day No. This value is the total number of days that have passed since the Notice to Proceed date for your project

2 Shift Day or Night.

3 DFW Project No. Input the project number.

4 Date Enter the date that the quantity noted was completed (format i.e. 09.13.2018)

5 Project Name List project name

6 Contractor List name of Prime Contractor and Subcontractor if applicable

7 Weather Document temperature range during shift including atmospheric conditions

8 Hours Worked Shift start time and end time. AM/PM

9 Item Code No. Line item number. i.e. "29"

10 Item Description of Line item exactly as per the contract documents

11 Location Describe location of work quantified in the IDR, Use stations, offsets, coordinates, system numbers,
structure names of numbers, or other means of description or location.

12 Quantity & Units Enter the Quantity and bid unit used to track progress. Make sure to use significant digits
(i.e. whole numbers for CY and decimals for acreage).

13 Evidence of Material Insp. Evidence of material inspection. Tickets, visual, cut sheets, efc..

14 Quantity Bk. To be completed by Office Engineer upon entering IDR into quantity book.

15 Calculation and Sketch This location is for reserved for inspector’s calculations and sketches. Always include a sketch or calculation.

IDRQ Instructions

Box

February 2020



16

17

18

19

20

21

22

23

24

IDRQ Instructions

Verified and Agreed to by:

Estimated Quantity
Checkbox

Final Measurement
Checkbox

Attachment Total Pages
Inspected by:

Measured by:
Calculated by:

Checked by:

Construction Manager

This line should be signed by a Contractor's representative. Always get a list of the appropriate personnel to agree to
quantities form the Contractor prior to utilizing this form.

Mark this box if the IDR represents an estimated quantity.

Mark this box if the IDR represents a final quantity that has been agreed to and signed off by the contractor.

Enter the number of pages of attached backup documentation including the IDR form.

Signed and initialed by the responsible inspector.

Signed and initialed by the responsible inspector.

Signed and initialed by the responsible inspector.

Signed and initialed by Office Engineer or Construction Manager, or other independent inspector after reviewing.

The IDR will be signed by the Construction Manager.

February 2020



IN\I[\A/J

L1 V¥
DFW Airport System
Inspector's Daily Report for Quantity Book IDR #: 120-10
Contract Day No: 4 of 135 Shift: Day
DFW Project No. OH.6130.200.50.220 Date: 09.13.2018
Project Name: Runway 13L / 31R Rehabilitation
Contractor; Reyes Group
Weather: 78 degrees F
Hours Worked: Shift Start @ 7 AM and End @ 4:30 PM
Item Code . Quantity & Evidence of Material Quant.
No. Item Location Units Inspection Bk.
HMA, 6", N50 Base CSE  |Sta. 124+00 to 1,120 Visual / Delivery Tickets 4

1 2 4 Sta. 126+50

Calculations and/or sketches:
12650 - 12400 = 250LF / 12.5 ft Wide

Base Course = 119.5 Ib/in/sy
250 (L) x 12.5 (W) x 6 (in) x 119.5 (Ib/in/sy) /2000 = 1,120 Tons

Jim "Super" Smith
Verified and agreed to by:

This is: Estimated progress measurement (Item no.: 124)
|:| Final field measurement (ltem no.: )
Remarks: (e.g., instructions to Contractor, special problems, sketches with dimensions for final measurements, computations, number of persons

working, hours worked). Use reverse side, if needed. See attached backup, (maps, sketches reports, etc.) _2_Pgs. Total.

Initials Date
Inspected by: WLT 09.13.2018
Measured by: WLT 09.13.2018
Calculated by: WLT 09.13.2018
Checked by: JMV 09.20.2018 Jackson Anderson

Construction Manager

IDRQ Sample February 2020
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L1 VY%

Inspector's Daily Report for Quantity Book IDR #:
Contract Day No: Shift:
DFW Project No. Date:
Project Name:
Contractor:
Weather:
Hours Worked:

Item Code ltem Location Quan?lty & Evidence of _Materlal Quant.

No. Units Inspection Bk.
Calculations and/or sketches:
Verified and agreed to by:
This is: |:|Estimated progress measurement (Item no.: )
|:|Final field measurement (ltem no.: )
Remarks: (e.g., instructions to Contractor, special problems, sketches with dimensions for final measurements, computations, number of persons
working, hours worked). Use reverse side, if needed. See attached backup, (maps, sketches reports, etc.), pgs. total.
Initials Date

Inspected by:

Measured by:

Calculated by:

Checked by:

Construction Manager
February 2020

IDRQ Blank
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L1 VY
DFW Airport System
DIGITAL PHOTO LOG
PHOTO *
N_T DATE LOCATION DESCRIPTION DIRECTION EMPLOYEE NAME FILE NO.
()] (2) 3) (4) (5) (6) (7)
Photo Log Example February 2020



Photo Log Form Directions

I\I—\A/
L71 VY%

*Reference numbers on the preceding Procedure Form marked "Example”. Follow the completion directions below.

Number Title: Directions
1 Photo No. Input the photo number numerically (i.e. 1, 2, 3, 4...)
2 Date Input the Date that the photo was taken in the format month.day.year (i.e. 09.13.2018)
Input the location where the photo was taken and of what. Be concise and use as specific of a
3 Location location as possible.
4 Description Provide a written description of the activity that the photo showing
5 Direction * Provide the direction that you were facing when taking the photo
6 Employee Name Enter the name of the person who took the photo
Enter the file number for the photo. It must be unique in nature and following the standard file
7 File No. naming convention. (i.e. Photo6-Earhwork_WLT_03.13.2018)

Photo Log Directions

February 2020
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Station 234+50

L 1l

L1 V¥
DFW Airport System
DIGITAL PHOTO LOG |
PHOTO
o | DATE LOCATION DESCRIPTION DIRECTION * EMPLOYEE NAME FILE NO.
1 09.13.2018 Runway 13L/32R Left Shoulder | 5o course paving on left Looking NW Jimmy Rogers 6130.10-Photo1-WLT 09.13.2018

Photo Log Sample

February 2020
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DIGITAL PHOTO LOG |
% DATE LOCATION DESCRIPTION DIRECTION * EMPLOYEE NAME FILE NO.
Photo Log Blank February 2020
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Field Book Example

41 Fowetb AEAsE. RETURN 0!
Address 39? 3 % SERNiceE RBD, .
PFl AR Rp T, TX 152!
Telephone (AT 2D Q117871

NPAST 5,
S o2,
@ 3i

This book is published on fine Monadnock Wet-Strength paper, specially treated
for maximum archival service, and protected by a water resistant surface sizing.

Printed and Bound in the United States Publishing Co. Inc.
=  Published by Bogside Publishing, Inc. Bow, NH 03304
bogsidepublishing.com

2.0 Field Book Example Page 1 of 2 February 2020
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2.0 ISSUES, DEFICIENCY NOTIFICATIONS, and L/l VY
NON-CONFORMANCE REPORTS

2.1 PURPOSE AND OVERVIEW

Although the Contractor is responsible to construct each part of the project in accordance with
the contract requirements, there may be factors that arise during construction that make this
difficult. It is important that DFW encourage and allow the Contractor latitude to identify Issues,
Deficiencies and Non-conformances itself and propose a solution to which DFW may then
respond.

The identification and correction of deficient work is the main responsibility of the Contractor.
DFW should provide support and work with the Contractor’s Quality Control personnel to solve
the deficiency in a mutually acceptable manner.

If the Contractor is unwilling or unable to identify an Issue or Deficiency or on their own, DFW
then has the option to issue a Deficiency Notification and/or a “Non-Conformance Report” (NCR).

Although a Non-conformance is always a Deficiency, a Deficiency is NOT always a Non-
conformance. Non-conformances should be limited to those situations in which the Contractor is
unable or unwilling to correct a deficiency for which they have been made aware. The NCR
creates a non-compliant situation which DFW cannot accept, and for which the Contractor must
be held accountable for correcting to DFW’s satisfaction.

Each Issue MUST BE documented with photos
o Communicate with DFW PMCM Team and Contractor’s on-site project team
Generate Issues
= Issue: Work or Materials does not meet the requirements of the plans and/or
specifications.
= Deficiency Issue: Issue is not corrected before the end of the issuing Inspector’s work
shift.
e The Inspector will inform the on-site Contractor’'s representative of work for any issues
that are recorded.
o The Lead Inspector will notify the Construction Manager of deficiencies and make
recommendations regarding issuing a Deficiency Notification or, in limited cases, an NCR
e Collect and record backup information (photos, etc.) in BIM360

2.2 |ISSUES CREATION AND MANAGEMENT in BIM360

+ Track ongoing Issues within the bounds of a project

* Ensure Quality Assurance is being upheld

« Establish a document record of all current and archived issues
¢ Maintain a communication line with the PMCM Team

¢ Maintain a communication line with the Contractor

*  Open the BIM360 Application from your iPad or Tablet
* In the lower left-hand side of the screen, tap the 3 lines; this is the initial directory
» If the initial directory is gray, you will need to sync the project for the first time

Issues, Deficiency Notifications, NCRs Page 1 of 6 September 2020
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2.0

ISSUES, DEFICIENCY NOTIFICATIONS, and LI VYV
NON-CONFORMANCE REPORTS

Issues will be the first tab at the top of the initial directory
Follow steps as described in the BIM360 Issues Management Training
Export Issue Notice and Upload to Unifier

Issue Management

How to create an Issue and upload to Unifier

Ehec‘ifl‘isls i +

- = 78 Completed
Q Sei IC tl

#S Quantities/Pay Items test 2 Activities Inspected —_— .
Breanna Brown (VRX)

—_ 10% Completed

T Aug 0 sk
33333333 2.1 Activity #1
Note: = )
Create an activity
€L specific issue
#3 QA Inspectic
nna Brown (VRX) —
94% Completea
3 2ul 29, 2020 (Optiora 1. Select “Issue”
2.2 Activity #2 on the checklist

#2 QA Inspection Daily Report
Eric ¢ nationa

{ernandez (DFW Inter

100% pleted
Bad concrete

CIEGE © Jul 29, 2020
#1 QA Inspection Daily Report
Tony Keefer (DFW International Ai
100% Completed 1 D Al ™
Filters %+
) cocument A 1ssue Chaecklists & s & Daily Lc

LA
L1 YY

Issue Management

How to export an Issue Notice

& dfwia-unifier.oracleindustry.com

[ ] Primavera Unifier
ORACLE Primavera Unifier - % @ Breanna Brown
w < Integrated AO. Terminal F Pha Rehabilitate La. NE End-Aroun... Curbside Reall... Skylink Ramp ... Replace East ... s
. e DFW > DCC » Civil > Replace EastAli N
P Issue Notice
+ Create Actions v View| Al Records v X s v|lQ
Record Delivery Order Construction
@ 0 Mumber Issue Notice Title Reference Delivery Order Title Contract Reference c

B Reports

™LA
/1 ¥YY¥Y

See Attachments: BIM360 Issues Management Training Module and Unifier Issue Notice BP

Issues, Deficiency Notifications, NCRs Page 2 of 6 September 2020



IN\[\A/

2.0 ISSUES, DEFICIENCY NOTIFICATIONS, and L/l VY
NON-CONFORMANCE REPORTS

2.3 DEFICIENCY NOTIFICATION (CM Team Responsibility)

The objective is to create a written description of a Deficiency, track its closure and, if necessary,
create a “Root Cause” and resolution to avoid repeating the condition moving forward. The
Deficiency Notification must reference the applicable Technical Specification violation.

A Deficiency is an unresolved Issue identified by the CM Team during the construction process,
and may include, but is not limited to, the following:

Means and Methods
Workmanship
Materials

Equipment

Lack of personnel
Installation parameters

The QA Inspector submits Issues Notices to the CM Team using the BIM360 Issues
Management process.

For unresolved Issues, the CM Team will create a Deficiency Notification, which may
also be prepared by the Contractor. The CM will determine what Issues require
Deficiency Notifications and keep a Deficiency Log for each project. The Deficient
conditions will be uniquely numbered so that they can be tracked effectively.

The Contractor will have 72 hours to propose a resolution to the condition, for the CM
Team’s review. The Engineer of Record may be brought into the process if the
Deficiency resolution is related to the intent of the contract technical specifications.

A Deficiency may stay open and active for no more than 14 calendar days from the date

of issuance. Within that time, one of the following must occur:

o The Deficiency is corrected to the CM Team'’s satisfaction. If this occurs, the item is
re-inspected by the QA Inspector, documented appropriately, and the Issue is
closed;

e A correction is agreed-upon between the Contractor and CM Team, and both agree
that the correction is not urgent and can be completed at the Contractor’s discretion
prior to final acceptance. If this occurs, the item is transferred to the Project Punch
List for continued tracking, and the Deficiency is closed;

o A Deficiency is not corrected, and an acceptable solution has not been agreed to by
both parties. If this occurs then the Deficiency will be elevated to a Non-
Conformance, a Non-Conformance Report (NCR) will be issued by the CM Team,
and the Deficiency is closed.

Depending on the severity or repetition of the Deficiency, the CM may direct the Contractor
to complete a “Root Cause” analysis. When so directed, the Root Cause analysis
completed by the Contractor will contain, at a minimum, the following:

e How the Contractor plans on eliminating the repetition of the deficiency

e Additional training

Issues, Deficiency Notifications, NCRs Page 3 of 6 September 2020
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2.0 ISSUES, DEFICIENCY NOTIFICATIONS, and L/l VY
NON-CONFORMANCE REPORTS

Holding an additional pre-activity meeting

Providing a communication plan

Providing a drawing control log

Hiring additional personnel

Any other means that the Contractor feels would eliminate the repetition of the
deficiency

2.4 NON-CONFORMANCE REPORT (CM Team Responsibility)

The objective is to create a written description of the type of Non-conformance work and track the
closure and resolution. The NCR must reference the applicable Technical Specification violation.

These NCR situations should be a last resort as this situation results in rework cost, loss of good
faith in the Contractor’s efforts and can result in an unsafe condition. The NCR s, for all intents
and purposes, a “Quality Ticket” to the Contractor and reflects poorly on their ability to perform
acceptable installations.

A Non-conforming condition is identified in the construction process, which may include,
but is not limited to, the following:

¢ Means and Methods

Workmanship

Materials

Equipment

Lack of personnel

Installation parameters

The Contractor should immediately be notified and given the opportunity to stop work until
the Non-conformance can be appropriately addressed.

The QA Inspector will contact the Construction Manager (CM) and report the issue. The
QA Manager should also be notified.

In most situations, both the CM and QA Manager should visit the work site and view the
situation first-hand, depending on the urgency of the situation.

The Non-conformance Report (NCR) will be completed by the CM and given to the

Contractor.

o The completed NCR will also include the resolution by the CM Team.

¢ The NCR condition will be uniquely numbered so that it can be tracked effectively, and
the CM Team will keep an NCR Log for each project.

The Contractor is typically given 14 calendar days to correct the NCR condition. However,
at the discretion of the CM, a shorter timeframe may be imposed.

The Engineer of Record may have to review the corrective action to agree that the
correction will meet the intent of the technical specification.

Issues, Deficiency Notifications, NCRs Page 4 of 6 September 2020



IN\[\A/

2.0 ISSUES, DEFICIENCY NOTIFICATIONS, and L/l VY
NON-CONFORMANCE REPORTS

The Contractor will correct the condition and contact the CM Team for confirmation and
acceptance. Any re-inspection should be properly documented with pictures, plans,
reports of testing results, etc.

Once the correction of the NCR condition has been inspected and approved compliant,
the Contractor will be issued a letter, signed by the CM, for acceptance and release of
payment.

Should the condition not be corrected, the CM Team will withhold the associated cost of
the NCR work.

2.5 NCR DOLLAR ASSIGNMENTS

The objective is to establish and validate the costs associated with NCR money held scenarios.
The DFW Staff produces a Non-conformance Report (NCR).
The NCR must list a referenced Technical Specification, Contract Line Iltem Number, and
corresponding Quantity for the item.
The CM or QA Manager will assign a dollar value to the NCR using the Line Item Unit
Price and Quantity from the NCR to determine a Non-conformance contract value.
The CM will use the information to negotiate an agreement to have the NCR closed.
The NCR will not be closed until a copy of such an agreement has been corrected or
negotiated by the CM.
In addition to the dollar value withheld, the CM with assistance from the QA Manager will
negotiate an extended warranty or performance bond, with the Contractor to cover any
deficiencies that may arise from the deficient work for a period to be determined by the
CM, QC Manager and Contractor.
A copy will be attached to the NCR for closure.
The CM will be responsible to tracking dollars held on tracking form.

Scenario #1 The 10% Penalty is Over $5,000 plus Warranty
A proposed penalty of 10% will be calculated for any deficient item where the total Line Item Cost
exceeds $5,000.
e Example: The structure has developed a crack in it and the Contractor refuses to fix the
issue. The cost for the Line Item is $1,750,000.
e The proposed penalty will be $1,750,000 x 10% = $175,000
e |n addition, the CM will negotiate an additional warranty for a period determined to be fair
and equitable.

Scenario #2 The 10% Penalty is Under $5,000 plus Warranty
The proposed penalty, included in Scenario #1, is calculated to be below $5,000. In this case the
penalty will be $5,000.
e Example: The paving Contractor has not taken cores for the roadway paving prior to
paving the surface over it. The Contractor paved 600 Tons at a cost of $70/ton.
e The proposed penalty will be 600 x $70 = $42,000 x 10% =%$4,200.
e Due to the penalty being below $5,000 the penalty will be a minimum of $5,000.

Issues, Deficiency Notifications, NCRs Page 5 of 6 September 2020
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2.0 ISSUES, DEFICIENCY NOTIFICATIONS, and L/l VY
NON-CONFORMANCE REPORTS

e |n addition, the CM will negotiate an additional warranty for a period determined to be
fair and equitable.

Scenario #3 The Actual Cost-plus Warranty
The cost for the Line Item work is below $5,000. The penalty will be for the full amount of the
work.
e Example: The Contractor forgot to take cylinders on concrete installed for a building
footing 30 LF long. The Line Item cost of the footing concrete is $80 / LF.
e The proposed penalty will be $80 x 30LF = $2,400
¢ |n addition, the CM will negotiate an additional warranty for a period determined to be fair
and equitable.

Concerns: This type of penalty structure has the potential to create additional items that must
be tracked.

= Each item will have a warranty associated with it.

*= We cannot sacrifice Quality for $

= The warranty periods determined by the negotiation will have to be tracked in a
Warranty Log for the project.

2.6 ATTACHMENTS

% BIM360 Issue Management Training Module
% Unifier Issue Notice BP
Deficiency Notification Report Example Forms — For reference only (CM responsibility)

NCR Example Forms — For reference only (CM responsibility)

Issues, Deficiency Notifications, NCRs Page 6 of 6 September 2020
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Issue Management

In this section you will learn/ review how to
create and export an issue as a PDF and
upload into Unifier.

SEPTEMBER 2020
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Issue Management

How to create an Issue and upload to Unifier

Checklists L

0000 Project (Training) Template

Q search by 1D, title or location

#5 Quantities/Pay Items test
Breanna Brown (VRX)

P 10% Completed
® Aug 5, 2020
#4 Quantities/Payv Ttams

Breanna Brown Note'

Create an activity
specific issue
#3 QA Inspectic
Breanna Brown (VRX)

94% Completed

© Jul 29, 2020
#2 QA Inspection Daily Report

Eric Hernandez (DFW International Airport)
100% Completed

@ Jul 29,2020
#1 QA Inspection Daily Report

Tony Keefer (DFW International Airport)
100% Completed

Filters ==

—-—

=
‘] Documents A Issues

=T
=

2 Activities Inspected

2.1 Activity #1

Test

Issue

(Optional)

2.2 Activity H2

Bad concrete

1 Activi , 42

Issue

Checklists

Note

1. Select “Issue”
on the checklist

| Note

@ Sync

SEPTEMBER 2020

d' Daily Logs

7/8 Completed

] Photo

Photo

ss* Maore

M\IZ\A/J
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Issue Management

How to create an Issue and upload to Unifier

Select a “Type” > Title the Issue > Add a “Description” > “Assign to” the CM >Select “Root Cause” > attach photo(s) > Create

Cancel New Issue

Type

Ay It pesign
Status
| OPEN

Title ™

Activity #2

11/100

Description

Tap to add a descriptio

0/1,000

Assigned to
Unassigned

Due Date
Unscheduled

Owner
Breanna Brown

Root Cause

Unspecified

M\IZ\A/J
L1 VYV
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Issue Management

How to create an Issue and upload to Unifier

_ Checklists oo

0000 Project (Training) Template

Q Search by ID, title or location

@ Yesterday

#11 QA Inspection Daily Report
Breanna Brown (VRX)

94% Completed

@ Yesterday
#8 QA Inspection Daily Report -Drone
Breanna Brown (VRX)

97% Completed

@ Aug 6,2020
#7 QA Inspection Daily Report

Breanna Brown (VRX)
91% Completed

IN PROGRESS

#6 Quantities/Pay Items test 2
Breanna Brown (VRX)

— 10% Completed

© Aug 5, 2020

IN PROGRESS _
#5 Quantities/Pay Items test

Breanna Brown (VRX)

© Aug 5, 2020

— 10% Completed
@ Augs, 2020

#4 Quantities  Fijters =

Breanna Browrryereay

\
.] Documents A Issues

=t 7/8 Completed
1 Daily Report @ completed

Issue Note s] Photo

2 Activities Inspected — 1/2 m

2.1 Activity #1

Training

8 (| Training issue b
Note Photo

Checklists m Sync ‘ Daily Logs “** More

SEPTEMBER 2020
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Issue Management

How to export an Issue Notice

Or: dfwia-p6.ora...

) AUTODESK' BIM 360

DFW International Airport

Primavera U...

i Field Management

Issues

ID v

Showing 1

28

Templates

Type

Design

Design

Design

Design

Observation

Observation

6 of 6

Sub-type

Design

Design

Design

Design

Observation

Observation

@ field.b360.autodesk.com

Filteringison @

Title

Training issue

Training

Test

Activity #2

Bad pour

Activity #2

E3 BIM 360 Fiel...

0000 Project (Training) Template »

ocation

dfwia-un

DAILY LOGS

Primavera U...

¢

Oracle CEGB...

Go to BIM360 Safari
(web version) > Field

Management > “Issues” -
> Select the Issue

Assigr

Robert Brown

Breanna Brown

Robert Brown

SEPTEMBER 2020

DFW Internati..

VRX

DFW Internati..

Oracle CEGB...

Linked document ¥

) cpoo1l

Oy cpoo1

AR S ™N\I—\A/J
LI VV



29

Issue Management

How to export an Issue Notice

8 field.b360.autodesk.com

E3 BIM 360 Fiel...

Preparing to download
8_Training issue_08-20-20.pdf

X

© Issue #8 PDF report will be
DETAILS ATTACHMENTS ACTIVITY emailed to you when ready

Tralninglone ¢ Double check the
Created by Breanna Brown (VRX) on Aug 19, 2020 information and photo

attached > select
Assigned to Type eXDOFt iCOﬂ

Robert Brown Design

Due Date Jwner

Unspecified Breanna Brown

Location Root Cause

Unspecified Design Deficiency

Location Details

Unspecified
Linked document
Unspecified
Description
Training issue

Response

SEPTEMBER 2020

X

M\IZ\A/J
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Issue Management

How to export an Issue Notice

Open Outlook on iPad >
“Other” inbox > select
email with report >
“Download report”

0000 Project (Training) Template BIM 360 Issue #8: Training issue

@ Autodesk BIM 360 Reports
To You

Cantion: The swad ngamed furis of DFW Arpern [ el ek Bk o S0a0 STASRMARES LAUAA Yoll TAESIATE |

Project: 0000 Project (Training) Template

Report Title: Issue #8: Training issue

Download report




Issue Management

How to export an Issue Notice

nl Q Search or enter website name Q)

dfwia-p6.ora... Primavera U... BIM 360 Fiel... Ed Favorites dfwia-unifier... Oracle CEGB... lavera U...

You will then be
redirected to a
“download” window

Do you want to download “Issue #8_ Training

issue.pdf"?
Download

N\ICAA/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

@ field.b360.autodesk.com

El BIM 360 Fiel...
Downloads

? AUTODESK BIM 360 \ DFW International Airport > 0000 Project (Training) Template

. Issue #8_ Training issue
2 Field Ma nagement CHECKLISTS ISSUES DAILY LOGS 249 KB

Templates . -
i=3iles ol Issue #7_Training
140 KB
Q ] . » Lreate I
v Q G@EEX Again, redirected to o reate issue
BIM360 Field
IDv Type Sub-type Title Company Due date Linked documeni £}
Management > select
8 Design Design Train the dOWI’lload icon > Wwn DFW Internati..
select report from drop
7 Design Design Train d rown VRX = b cboo1
own
6 Design Design Test
5 Design Design Activity #2
4 Observation Observation Bad pour - Robert Brown DFW Internati.. - O cboo1
1 Observation Observation Activity #2

IN\I\A/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

Done Issue #8_ Training issue

Issue #8_ Training issue

0000 Project (Training) Template

ISSUE DETAIL

#8 Training issue

Select the export icon Copy
> “Save to Files” >
select file location “on Print
my iPad”

i ith D i
Type / Subtype Design / Design Sign wi st

Location Import to Acrobat }x,
Root Cause Coordination > Design Deficiency
Checklist Source QA Inspection Daily Report Save to Files =
Reference Drawing
Add Tags S

Creator Breanna Brown VRX
Issue Owner Breanna Brown VRX
Assignee Robert Brown DFW International Airport

Description Training issue

PHOTOS
M\IZ\A/J
LJ1I VYV

AL T8 2020 81 50631117 AL
2400 Avialion Drive

EMBER 2020



Issue Management

How to export an Issue Notice

Note:
you can create folders in “O My |Pad to
organize your downloads by :
add folder i
See below for examples
Item will be saved to “Issue Notices” on On My iPad.

E Issue #8_ Training issue

> “Downloads”
> “Save”

Downloads

GarageBand for iOS

|

Issue Notices
Keynote
Numbers
OfficeSuite

Pages

A
—
[k |
—

A Dailv Rennrts

IN\I\A/
SEPTEMBER 2020 /1 VvV
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How to export an Issue Notice

Browse b ' Y IFaf Issue Notices

Q Search Issue #8 PDF is
now on my iPad,
B icloud Drive ready to upload

_ to Unifier
@ On My iPad

A< Adobe Document Cloud

Locations

OneDrive ; %
g Issue #8_ Training
issue

. Recently Deleted Yesterday at 4:52 PM

Favorites
E Downloads

“ Downloads

Tags
Red
Orange

Yellow

Green 1item, 105.68 GB available




Issue Management

How to export an Issue Notice

& dfwia-unifier.oracleindustry.com

Primavera Unifier

ORACLE Primavera Unifier @ W (2 [::BreannaBrown v

Terminal F Pha... Rehabilitate La... NE End-Aroun... Curbside Reall... Skylink Ramp ... Replace East ... %+

Replace East Airfiel... DFW » DCC » Civii » ReplaceEastA.i... &

Alerts
: Issue Notice
uMail
s Collaboration -~ Create Actions w View All Records X @) = Q Ee} @

Information
Record Delivery Order Construction
[ﬂj Number + [Issue Notice Title Reference Delivery Order Title Contract Reference c

Document Control
Document Submittal
Correspondence
Contract Managem..
Project Management
Construction Mana..
Contractor Daily R...
Requests For Infor...

Material Testing

B Reports

IN\I\A/
SEPTEMBER 2020 /1 VvV



Create New |Issue Notice

Details

Issue Notice Title *

Issue Management

& dfwia-unifier.oracleindustry.com

Creation Date

Training Issue

Attachments @J

&

Project No. TER-042

Send Save
Comments Linked Records Linked Mail
Name ® [ Tite

4 Unpublished Attachments

Status @ >
[ ]
4 Delivery Order / Construction Contract Information o

Delivery Order Reference Q Delivery Order Title Consultant Name
‘ Type a Delivery Order ... v ™ ‘

:; Construction Contract Title Contractor Name
Construction Contract Reference Skylink Ramp Level Security/Emel Skye Building Services, LLC
|9500601 - Q-@J

4 |ssue Information

Issue Occurrence Date *

Autodesk Record No. *

| 08/18/2020

_m [

Issue Description * @)

Inspector Comments

Describe the issue. Copy/paste BIM360 report

Issue Type Category *

Issue Type *

‘ Observation v ‘ ’ Quality v ‘
Root Cause Category * Root Cause * Total: 3
‘ Quality v ‘ ‘ Installation

37

SEPTEMBER 2020

B 0DA20FA9-3A16-4C87-...
B DES01D05-6669-457F-8...

Issue #8_ Training issue....

M\IZ\A/J
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Issues _[_
0000 Project (Training) Template

Details | Open 7
#8 Training issue
2, To Robert Brown (DF..International Airport) Training issue ' Sfisierad
aD E—
raining issue i Closed
#7 Training Approve and close
= To Robert Brown (DF..International Airport) +
[ opEN ﬂ . Void
#6  Note: The Inspector
° | . . Type
closes the issue in >
i BIM360 > Select the issue that
. was upl in
#5 Activity #2 as up O,aded' to rational Airport)
- Unassigned Unlﬂer
> Select “Open”
> Select “Closed”
#4 Bad pour .
. To Robert Brown (DF..International Airport) Locatlon.
Unspecified
{ OPEN J
Location details
43 od ot Enter text
- To Breanna Brown (VRX)
Owner
Breanna Brown
#2 Wrong dist  Filters =
. Unassigned
ﬁ] Documents A Issues Checklists m Sync " Daily Logs *** More
MN\IC\A/J
LJ1I VYV

SEPTEMBER 2020
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Issues +

0000 Project (Training) Template

Q Search by # or issue text fields

#8 Training issue
To Robert Brown (DF..International Airport)

#7 Training
To Robert Brown (DF..International Airport)

#6 Test
Unassigned

#5 Activity #2
Unassigned

| OPEN 4

#4 Bad pour
To Robert Brown (DF..International Airport)

#3 Bad pour
To Breanna Brown (VRX)

#2 Wrong dist  Filters ==
Unassigned

L
.] Documents A Issues

Details Activity

Training issue

Training issue

The issue is now
closed in BIM360 > all
communication is
handled within Unifier port)

Due Date
Unscheduled

Location
Unspecified

Location details

Enter text

Owner
Breanna Brown

Checklists @ Sync “ Daily Logs

SEPTEMBER 2020

*e= More

M\IZ\A/J
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Issue Management

How to create an issue

Issues +

0000 Project (Training) Template

Q, Search by # or issue text fields

#5 Activity #2

Unassigned

1. Create a new
issue > select “+”
#4 Bad pour plus sign

To Robert Brown (DF..International Airport)

#3 Bad pour
To Breanna Brown (VRX)

#2 Wrong distance

Unassigned

© Aug 7, 2020 Select or create an issue

Note:

p Create a project

specific issue by

selecting “Issues”

Filters =

M\IZ\A/J

ﬁ] Documents A Issues %éﬁisgf_lEiVIBER 2 Ofsync @& Daily Logs +** More L/ Yv



Issue Management

How to create an issue

Select a “Type” > Title the Issue > Add a “Description” > “Assign to” the CM >Select “Root Cause” > attach photo(s) > Create

Cancel New Issue
Type
Pay Il pesign

Status
| OPEN

8 [Title
Activity #2

Description
Tap to add a description

11/100

0 /1,000

Assigne to
Unassigned
3 Due Date

Unscheduled

Owner
Breanna Brown

Root Cause
Unspecified

- IN\I\A/
SEPTEMBER 2020 /1 vy




Issue Management

How to export an Issue Notice

Or: dfwia-p6.ora...

) AUTODESK' BIM 360

DFW International Airport

Primavera U...

i Field Management

Issues

ID v

Showing 1

42

Templates

Type

Design

Design

Design

Design

Observation

Observation

6 of 6

Sub-type

Design

Design

Design

Design

Observation

Observation

@ field.b360.autodesk.com

Filteringison @

Title

Training issue

Training

Test

Activity #2

Bad pour

Activity #2

E3 BIM 360 Fiel...

0000 Project (Training) Template »

ocation

dfwia-un

DAILY LOGS

Primavera U...

¢

Oracle CEGB...

Go to BIM360 Safari
(web version) > Field

Management > “Issues” -
> Select the Issue

Assigr

Robert Brown

Breanna Brown

Robert Brown

SEPTEMBER 2020

DFW Internati..

VRX

DFW Internati..

Oracle CEGB...

Linked document ¥

) cpoo1l

Oy cpoo1

AR S ™N\I—\A/J
LI VV
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Issue Management

How to export an Issue Notice

8 field.b360.autodesk.com

E3 BIM 360 Fiel...

Preparing to download
8_Training issue_08-20-20.pdf

X

© Issue #8 PDF report will be
DETAILS ATTACHMENTS ACTIVITY emailed to you when ready

Tralninglone ¢ Double check the
Created by Breanna Brown (VRX) on Aug 19, 2020 information and photo

attached > select
Assigned to Type eXDOFt iCOﬂ

Robert Brown Design

Due Date Jwner

Unspecified Breanna Brown

Location Root Cause

Unspecified Design Deficiency

Location Details

Unspecified
Linked document
Unspecified
Description
Training issue

Response

SEPTEMBER 2020

X

M\IZ\A/J
L1 VYV



Issue Management

How to export an Issue Notice

Open Outlook on iPad >
“Other” inbox > select
email with report >
“Download report”

0000 Project (Training) Template BIM 360 Issue #8: Training issue

@ Autodesk BIM 360 Reports
To You

Cantion: The swad ngamed furis of DFW Arpern [ el ek Bk o S0a0 STASRMARES LAUAA Yoll TAESIATE |

Project: 0000 Project (Training) Template

Report Title: Issue #8: Training issue

Download report




Issue Management

How to export an Issue Notice

nl Q Search or enter website name Q)

dfwia-p6.ora... Primavera U... BIM 360 Fiel... Ed Favorites dfwia-unifier... Oracle CEGB... lavera U...

You will then be
redirected to a
“download” window

Do you want to download “Issue #8_ Training

issue.pdf"?
Download

N\ICAA/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

@ field.b360.autodesk.com

El BIM 360 Fiel...
Downloads

? AUTODESK BIM 360 \ DFW International Airport > 0000 Project (Training) Template

. Issue #8_ Training issue
2 Field Ma nagement CHECKLISTS ISSUES DAILY LOGS 249 KB

Templates . -
i=3iles ol Issue #7_Training
140 KB
Q ] . » Lreate I
v Q G@EEX Again, redirected to o reate issue
BIM360 Field
IDv Type Sub-type Title Company Due date Linked documeni £}
Management > select
8 Design Design Train the dOWI’lload icon > Wwn DFW Internati..
select report from drop
7 Design Design Train d rown VRX = b cboo1
own
6 Design Design Test
5 Design Design Activity #2
4 Observation Observation Bad pour - Robert Brown DFW Internati.. - O cboo1
1 Observation Observation Activity #2

IN\I\A/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

Done Issue #8_ Training issue

Issue #8_ Training issue

0000 Project (Training) Template

ISSUE DETAIL

#8 Training issue

Select the export icon Copy
> “Save to Files” >
select file location “on Print
my iPad”

i ith D i
Type / Subtype Design / Design Sign wi st

Location Import to Acrobat }x,
Root Cause Coordination > Design Deficiency
Checklist Source QA Inspection Daily Report Save to Files =
Reference Drawing
Add Tags S

Creator Breanna Brown VRX
Issue Owner Breanna Brown VRX
Assignee Robert Brown DFW International Airport

Description Training issue

PHOTOS
M\IZ\A/J
LJ1I VYV

AL T8 2020 81 50631117 AL
2400 Avialion Drive

EMBER 2020



Issue Management

How to export an Issue Notice

Note:
you can create folders in “O My |Pad to
organize your downloads by :
add folder i
See below for examples
Item will be saved to “Issue Notices” on On My iPad.

E Issue #8_ Training issue

> “Downloads”
> “Save”

Downloads

GarageBand for iOS

|

Issue Notices
Keynote
Numbers
OfficeSuite

Pages

A
—
[k |
—

A Dailv Rennrts

IN\I\A/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

Browse b ' Y IFaf Issue Notices

Q Search Issue #8 PDF is
now on my iPad,
B icloud Drive ready to upload

_ to Unifier
@ On My iPad

A< Adobe Document Cloud

Locations

OneDrive ; %
g Issue #8_ Training
issue

. Recently Deleted Yesterday at 4:52 PM

Favorites
E Downloads

“ Downloads

Tags
Red
Orange

Yellow

Green 1item, 105.68 GB available




Issue Management

How to export an Issue Notice

& dfwia-unifier.oracleindustry.com

Primavera Unifier

ORACLE Primavera Unifier @ W (2 [::BreannaBrown v

Terminal F Pha... Rehabilitate La... NE End-Aroun... Curbside Reall... Skylink Ramp ... Replace East ... %+

Replace East Airfiel... DFW » DCC » Civii » ReplaceEastA.i... &

Alerts
: Issue Notice
uMail
s Collaboration -~ Create Actions w View All Records X @) = Q Ee} @

Information
Record Delivery Order Construction
[ﬂj Number + [Issue Notice Title Reference Delivery Order Title Contract Reference c

Document Control
Document Submittal
Correspondence
Contract Managem..
Project Management
Construction Mana..
Contractor Daily R...
Requests For Infor...

Material Testing

B Reports

IN\I\A/
SEPTEMBER 2020 /1 VvV



Create New |Issue Notice

Details

Issue Notice Title *

Issue Management

& dfwia-unifier.oracleindustry.com

Creation Date

Training Issue

Attachments @J

&

Project No. TER-042

Send Save
Comments Linked Records Linked Mail
Name ® [ Tite

4 Unpublished Attachments

Status @ >
[ ]
4 Delivery Order / Construction Contract Information o

Delivery Order Reference Q Delivery Order Title Consultant Name
‘ Type a Delivery Order ... v ™ ‘

:; Construction Contract Title Contractor Name
Construction Contract Reference Skylink Ramp Level Security/Emel Skye Building Services, LLC
|9500601 - Q-@J

4 |ssue Information

Issue Occurrence Date *

Autodesk Record No. *

| 08/18/2020

_m [

Issue Description * @)

Inspector Comments

Describe the issue. Copy/paste BIM360 report

Issue Type Category *

Issue Type *

‘ Observation v ‘ ’ Quality v ‘
Root Cause Category * Root Cause * Total: 3
‘ Quality v ‘ ‘ Installation

51

SEPTEMBER 2020

B 0DA20FA9-3A16-4C87-...
B DES01D05-6669-457F-8...

Issue #8_ Training issue....

M\IZ\A/J
LJ1I VYV



Issue Management

Issues _[_
0000 Project (Training) Template

Details | Open 7
#8 Training issue
2, To Robert Brown (DF..International Airport) Training issue ' Sfisierad
aD E—
raining issue i Closed
#7 Training Approve and close
= To Robert Brown (DF..International Airport) +
[ opEN ﬂ . Void
#6  Note: The Inspector
° | . . Type
closes the issue in >
i BIM360 > Select the issue that
. was upl in
#5 Activity #2 as up O,aded' to rational Airport)
- Unassigned Unlﬂer
> Select “Open”
> Select “Closed”
#4 Bad pour .
. To Robert Brown (DF..International Airport) Locatlon.
Unspecified
{ OPEN J
Location details
43 od ot Enter text
- To Breanna Brown (VRX)
Owner
Breanna Brown
#2 Wrong dist  Filters =
. Unassigned
ﬁ] Documents A Issues Checklists m Sync " Daily Logs *** More
MN\IC\A/J
LJ1I VYV

SEPTEMBER 2020
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Issue Management

Issues +

0000 Project (Training) Template

Q Search by # or issue text fields

#8 Training issue
To Robert Brown (DF..International Airport)

#7 Training
To Robert Brown (DF..International Airport)

#6 Test
Unassigned

#5 Activity #2
Unassigned

| OPEN 4

#4 Bad pour
To Robert Brown (DF..International Airport)

#3 Bad pour
To Breanna Brown (VRX)

#2 Wrong dist  Filters ==
Unassigned

L
.] Documents A Issues

Details Activity

Training issue

Training issue

The issue is now
closed in BIM360 > all
communication is
handled within Unifier port)

Due Date
Unscheduled

Location
Unspecified

Location details

Enter text

Owner
Breanna Brown

Checklists @ Sync “ Daily Logs

SEPTEMBER 2020

*e= More

M\IZ\A/J

L/

vy



Issue Management

How to create an issue

Documents Q

0000 Project (Training) Template

Plans Project Files

Documents Sort by v

=R

s L

3 | = ==} -
CD 001 ¢

DEMOLITION PL..IN TO STA119+50 —

15
Create a plan specific
issue > Select
“Documents” > Select
plan sheet

. ‘] Documents A Issues Checklists @ Sync ‘ Daily Logs ere More n ‘ A I
SEPTEMBER 2020 vy
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Issue Management

How to create an issue

cDboo1

1000

TN CONCRETE PAVEMENT ATICOVAL
| BEGIN ASPHALT

REMOVAL
| END CURB REUIONVAL
OTREE | e

—— o ST

BEGIN CONCAETE PAVEMENT AEMOVAL \
e R

w a"‘iﬁre; \ V- el

Ro- - \_-.r-\:'- LY “'\-'\-\-n\.\ e 5

141000 N2 L NN

0 3OWNHES B5

TGN I
DETAL A / HTA 1RSSR, M 2F R
v END CLRB »
VS DOLADS STA 1V T2 08 800 R
FLLL DERTH SAWCLT = /
/ /
ExSTING BLAND /
AND GATE TD /]
WPLACE /
llln’ EMD CURE AND GUTTER REMOVAL -
. X J BECIN CURB REWOVAL
E0CL BECIN CORCRITE REMOVAL
smmRn R ETA 11T+ 3088, 34 16 R /
END CONCRETE REMOVAL -/ /
END CLRE REMOVAL EXIETING F M TO
BEMN CURR AND GUTTER REMOVAL HEMAN lqn‘“
STAVIE=3887. MOT R "
| | nares:

A UMLESS OTHERWISE SHMOWN I THE PLANS TO BE
REMOVED, COMTRACTOR SHALL PROTECT
PLACE ANY

ONES AT NO COST T0 06w

T T Tt AR T LB
BTA V1245100, 1507 L) i J ! .
: e

I
e

S STA 1130100, 1 57 R
STAA I

.00, 1 507 A=)
T et 2 FULL DEPTH BAWCUT
e L i T i e o o

DETAL A
SCALE. 1= 1

/

L
WORDL WITH ALL STARDMOLDERS TO MARTAIN
ALTESS

ETA NG00, 18T

AGUTTER

| REMOVE CONCHETE PAVEMENT
MOV AsAL T
CONCAETE PAVEMENT
GENERAL HOTES:

1 L SHORN AT
LOCATION. CONTRACTOR SHALL FIELD LOCATE AL
XIS TING UTILITIES AMD COORIIMATE WiTH THE
UTILITY OWNERS FOR Asey CONFLICT PRIOR TO
O GINNING DT MOLITION WORK

CONTRACTOR EMALL PROTECT AL EXISTING
FEATURES INCL UDING BUT NOT LIMTED T SI0NS.
TIREES, PLANTS, LANDSCAPING PEATURES.
UTILITIES. IRAIOATION. STRUCTURES. AND ETC.

ARPOAT.

3 REMOVAL OF CORNCRETE GUTTER T
DRNEWATS WILL NOT BE PAKD SEPARATELT U1
BUDSOURY TO A

wiLL
OF DRIVEWAYS.

4 CUR REMOVAL WHERE CONCRETE PAVEMENT 15
BEING REMOVED WILL NOT BE PAD SEPARATELY
BUT WILL BE INCIDENTAL T CONCRETE PAVELENT
FEMOVAL

5 SHALL TAKE CARE
AS TO MOT Y
ADJACENT FAVEMENT SCHEDULED T0 REMAIN, ANY
DAMAGE WILL BE COMMECTED AT CONTRACTONS
i EEPEMSE

8 CONTRACTOR SHALL COOHDINATE REMOVAL WORK
W ADUACENT PRIOJECTS PROOR T0 BEGRNNIG.
COMGTRUCTION,

4411143

MCVA u.,,.—” orw vtervational aireort | ATKINS | 2mn

E:J/ Markup A Issue RFI
SEPTEMBER 2020

![ REMABILITATE LANDSIDE ROADWAYS, PHASE 4A II R I
B P P TP e B i

Iiz Measure

M\IZ\A/J

L/

vy
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Cancel

Issue Management

How to create an issue

cboo1

- END COMCRETE PAVEMENT AFMOVAL
MOWAL

| BEGHN ASPHALT RE
II BEGIN CURR & GUTTER REUAL
MEMOVE BOLLARDS -, BTA 113007 58, 008"
BEA '
N CL & GUTTER o
SEENOTED - ) i BTA 1153117 :un-‘ll
|7

- &N ENPLOVEE R

\ [/ STA 1SS 30 TTL

\\\\~\‘\\\\\\J\~\.

L)

END CURB REMOVAL-
STA 1147280, 2000 R

FULL DEFTH SAWCUT

EXISTING
A4 OLTY,

HEGE CURD & QUTTER RENOVAL

| A UNLESS OTHERWSE SHOWN B THE PLANS TO BE
i FEMOVED, CONTRACTOR SHALL PROTECT

EXISTING BOLLARDS AND REPLACE AMY
|I OHES AT 80 COST TO DFW ARPORT,

PNETAA T S DFW INTERNATI
L/ VY Rl 3003 5. SERV
A DFW AIRPORT, TX 15“1

R R D - ey
BT&II!-I‘IHIHL o Sl

STA VI0100, 107

1. ENSTING UTIITIES ARE SHOWN AT APPROXMATE
mnw mlwmmvwm!:m

mmwmwmro
umumm

COMTRACTON EMALL
mwmmour II7|' MED TO BRGNS,

TREES. LANDSCAPING FEATURES.
UTILITIES, IRAICATION. STRUCTURES. AND ETC
USALESE THEY ARE EMOWN T BE REMOVED ANDAOR
SELOCATED 34 FLANS. ANY DAMAGE T0 Toll
[EXITING FEATURES SHALL BE RESTORED TO PRE-
CONDITION AT NO COST TO DFW

ARPOAT
3 REMOVAL OF E GUTTE
(DRAEWATS WILL 10T BE PAID SEPARATELT BUT
GENERAL ROTES: WILL DE A5
P CONTRACTOR SHALL COORDINATE THE REMOVAL vl
WORK WITH ALL STAREMOLDERS TO MAINTAN 4 CUMRD REMOVAL WHERE CONCRETE PAVEMENT &5
ALCESS

5 COMTRACTOR BHALL TAKE CARFE IN DEMCLITION OF
EXISTING PAVEMENT Al TO HOT DAMAGE MY

ADMACENT PAVEMENT BCHETULED TO REMAIN ANY
DAMAGE WL BE CORMRCTED AT COMTRAL TORS
O EXFENGE
0 CONTRACTOR SMALL COOSIDMA TE REMOVAL WORN,
PROJECTS PRIOR
COMSTRUCTION.
REHABILITATE LANDSIDE ROADWAYS, PHASE 44 [——
I DEMOLITION PLAN - N. EMPLOYEE RD. BEGIN TO CD 001
t STA 11450
'-o i v CONTRACT WA O AT A AR AT W EF 3 T

SEPTEMBER 2020

™
L/

\A/J
vy



Issue Management

How to create an issue

X CD 001
X Issue #7
Details Activity
END CONCRETE PAVEMENT REMOVAL
BEGIN ASPHALT REMOVAL
END CURB REMOVAL o
REMOVE BOLLARDS BEGIN CURB & GUTTER REMOVAL Training

STA 113+07.56, 0.00°
(5 EA) e

Add description
END CURB & GUTTER REMOVAL

SEE NOTEB DETAIL A STA 115+31.32, 31.30'L

PAVEMENT REMOVAL m
'ULL DEPTH SAWCUT)
ZGIN CURB REMOVAL G N. EMPLOYEE RD.
STA 112+55.33, 0.00'
. ) Type
E . e BT e o W W | A VO Y S N W _:‘. @ ¢ Design
FD‘"- “'“‘«-\_,_‘__‘_ ____ \ -"1 U A S - . . 3
112:00 Assigned to
e Robert Brown (DFW
T — e International Airport)
7 : BEGIN CONCRETE REMOVAL — Due Date
EXISTING SECURITY GUARD END CURB AND GUTTER REMOVAL Unscheduled
BUILDING TO REMAIN IN PLACE BEGIN CURB REMOVAL

SEE DETAIL A STA 114+55.76, 24.29'R
Location
REMOVE BOLLARDS END CURB REMOVAL )
(4 EA) STA 114+72.96, 28.00' R Unspecified

FULL DEPTH SAWCUT
Location details

EXISTING ISLAND
AND GATE TO
REMAIN IN PLACE

Enter text

Linked Document
BEGIN CURB REMOVAL

STA 115+39.38, 28.00' R CD 001
END CONCRETE REMOVAL
! _______ ENDCURBREMOVAL ~ Owner
' ‘" Markup A Issue RFI 12 Measure r\ ‘ A I

o SEPTEMBER 2020 LJ1 VvV
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v| Q Management > “Issues”

Issue Management

How to create an issue

Go to BIM360 Safari(web version) > Field Management > “Issues” > Select the Issue

& field.b360.autodesk.com
Or: dfwia-p6.ora... Primavera U... E3 BIM 360 Fiel... difwia-unger... Oracle CEGB... Oracle CEGB...

) AUTODESK' BIM 360 DFW International Airport » 0000 Project (Training) Template = &d @

i Field Management CHECRRETS DAILY LOGS

Issues Templates

Go to BIM360 Safari
(web version) > Field

> Select the Issue

IDwv Type Sub-type Title —ocation Assigr Linked documen! £}
8 Design Design Training issue = Robert Brown DFW Internati...
7 Design Design Training - Breanna Brown VRX = ) cooo1
6 Design Design Test
5 Design Design Activity #2
4 Observation Observation Bad pour . Robert Brown DFW Internati.. - [ cpoo1
1 Observation Observation Activity #2
lofl

SEPTEMBER 2020

M\IZ\A/J
LJ1I VYV



Issue Management

How to create an issue
Double check the information and photo attached > Select export icon

a field.b360.autodesk.com

E3 BIM 360 Fiel...

DETAILS ATTACHMENTS ACTIVITY

Training issue

Double check the
Created by Breanna Brown (VRX) on Aug 19, 2020 information and photo

attached > select
Assigned to Type export icon

Robert Brown Des'gn

Due Date Jwner

Unspecified Breanna Brown

Location Root Cause

Unspecified Design Deficiency

Location Details

Unspecified
Linked document

Unspecified

Description

Training issue

Response h ‘ A I
SEPTEMBER 2020 /1 VvV




Issue Management

How to create an issue

POP-UP: “preparing to download” then “emailed to you when ready”

& field.b360.autodesk.com

re Primavera U E3 BIM 360 Fiel... 1fw inifier. Primavera U..

_ Preparing to download ¢
8_Training issue_08-19-20.pdf

@ Issue #8 PDF report will be X

DETAILS ATTACHMENTS ACTIVITY emailed to you when ready

Training issue

Created by Breanna Brown (VRX) on Aug 19, 2020 Preparing to down]oad
“‘issue” > check email
for pdf issue

Assigned to

Robert Brown

Due Date Owner

Unspecified Breanna Brown

Location Root Cause

Unspecified # Design Deficiency

Location Details

Unspecified
Linked document

Unspecified

Description

Training issue h ‘ A I
Response SEPTEMBER 2020 AT




Issue Management

How to export an issue as PDF
Open Outlook on iPad > “Other” inbox > select the email with report > “Download Report”

0000 Project (Training) Template BIM 360 Issue #8: Training issue

To You

@ Autodesk BIM 360 Reports

Open Outlook on iPad >
“Other” inbox > select
email with report >
“Download repo rt” Project: 0000 Project (Training) Template

Report Title: Issue #8: Training issue

Download report

Reply N\ICAA/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an issue as PDF

Redirected to a pop-up > select “Download”

4 Outlook 4:52 PM Wed Aug 19

Mm Q Search or enter website name

dfwia-p6.ora Primavera U BIM 360 Fiel B3 Favorites

You will then be
redirected to a
“download” window

Do you want to download "“Issue #8_ Training
issue.pdf”?

N\[C\A/
LI VYV
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Issue Management

How to export an issue as PDF

Again, you will be redirected to BIM360 Field Management > Select the download icon > Select the report from the drop down

& field.b360.autodesk.com

E3 BIM 360 Fiel...

) AUTODESK BIM 360 | DFW International Airport > 0000 Project (Training) Template =

i F]e[d Management CHECKLISTS ISSUES DAILY LOGS

Templat .o u
Issues ki Issue #7_Training
140 KB
Y| Q @EEX Again, redirected to Lreate I5sue
BIM360 Field
IDv Type Sub-type Title Company Due date Linked document Q
Management > select
8 Design Design Train the download iIcon > wn DFW Internati...
select report from drop
7 Design Design Train dOWh rown VRX g (» cpoo1
6 Design Design Test
5 Design Design Activity #2
4 Observation Observation Bad pour = Robert Brown DFW Internati.. - O cooo1
1 Observation Observation Activity #2

SEPTEMBER 2020

M\IZ\A/J

L/

vy



Issue Management

How to export an issue as PDF

>Redirected to the report > select the export icon > Select “Save to Files” on the export drop down > Select “On My iPad” > After selecting the location > Save

Issue #8_ Training issue 2) Note:
you can create folders in “On My iPad” to
organize your downloads by selecting the

add folder icon >
lssue #8_ Tralnlng issue S Fln o aiien

Item will be saved to “Issue Notices" on On My iPad.

0000 Project (Training) Template

ISSUE DETAIL

#8 Training issue

Select the export icon Copy
> “Save to Files” > > “Downloads”
select file location “on Print _ s “Save”
my iPad”

Sign with DocuSign
Type / Subtype Design / Design g 9

GarageBand for iOS

Location Import to Acrobat

Root Cause Coordination > Design Deficiency .
y : Issue Notices
Checklist Source QA Inspection Daily Report

Reference Drawing Keynote

Add Tags
Creator Breanna Brown VRX

Numbers
Issue Owner Breanna Brown VRX

Assignee Robert Brown DFW International Airport OfficeSuite

Description Training issue

Pages
PHOTOS

Alg T8, 20X 5l 5.54,

QA Dailv Renarts

ALY
Avtalion L1

IN\I\A/
SEPTEMBER 2020 /1 VvV



Issue Management

How to export an Issue Notice

Browse b ' Y IFaf Issue Notices

Q Search Issue #8 PDF is
now on my iPad,
B icloud Drive ready to upload

_ to Unifier
@ On My iPad

A< Adobe Document Cloud

Locations

OneDrive ; %
g Issue #8_ Training
issue

. Recently Deleted Yesterday at 4:52 PM

Favorites
E Downloads

“ Downloads

Tags
Red
Orange

Yellow

Green 1item, 105.68 GB available




Issue Management

How to export an Issue Notice

& dfwia-unifier.oracleindustry.com

Primavera Unifier

ORACLE Primavera Unifier @ W (2 [::BreannaBrown v

Terminal F Pha... Rehabilitate La... NE End-Aroun... Curbside Reall... Skylink Ramp ... Replace East ... %+

Replace East Airfiel... DFW » DCC » Civii » ReplaceEastA.i... &

Alerts
: Issue Notice
uMail
s Collaboration -~ Create Actions w View All Records X @) = Q Ee} @

Information
Record Delivery Order Construction
[ﬂj Number + [Issue Notice Title Reference Delivery Order Title Contract Reference c

Document Control
Document Submittal
Correspondence
Contract Managem..
Project Management
Construction Mana..
Contractor Daily R...
Requests For Infor...

Material Testing

B Reports

IN\I\A/
SEPTEMBER 2020 /1 VvV



Create New |Issue Notice

Details

Issue Notice Title *

Issue Management

& dfwia-unifier.oracleindustry.com

Creation Date

Training Issue

Attachments @J

&

Project No. TER-042

Send Save
Comments Linked Records Linked Mail
Name ® [ Tite

4 Unpublished Attachments

Status @ >
[ ]
4 Delivery Order / Construction Contract Information o

Delivery Order Reference Q Delivery Order Title Consultant Name
‘ Type a Delivery Order ... v ™ ‘

:; Construction Contract Title Contractor Name
Construction Contract Reference Skylink Ramp Level Security/Emel Skye Building Services, LLC
|9500601 - Q-@J

4 |ssue Information

Issue Occurrence Date *

Autodesk Record No. *

| 08/18/2020

_m [

Issue Description * @)

Inspector Comments

Describe the issue. Copy/paste BIM360 report

Issue Type Category *

Issue Type *

‘ Observation v ‘ ’ Quality v ‘
Root Cause Category * Root Cause * Total: 3
‘ Quality v ‘ ‘ Installation

67

SEPTEMBER 2020

B 0DA20FA9-3A16-4C87-...
B DES01D05-6669-457F-8...

Issue #8_ Training issue....

M\IZ\A/J
LJ1I VYV



Issue Management

Issues _[_
0000 Project (Training) Template

Details | Open 7
#8 Training issue
2, To Robert Brown (DF..International Airport) Training issue ' Sfisierad
aD E—
raining issue i Closed
#7 Training Approve and close
= To Robert Brown (DF..International Airport) +
[ opEN ﬂ . Void
#6  Note: The Inspector
° | . . Type
closes the issue in >
i BIM360 > Select the issue that
. was upl in
#5 Activity #2 as up O,aded' to rational Airport)
- Unassigned Unlﬂer
> Select “Open”
> Select “Closed”
#4 Bad pour .
. To Robert Brown (DF..International Airport) Locatlon.
Unspecified
{ OPEN J
Location details
43 od ot Enter text
- To Breanna Brown (VRX)
Owner
Breanna Brown
#2 Wrong dist  Filters =
. Unassigned
ﬁ] Documents A Issues Checklists m Sync " Daily Logs *** More
MN\IC\A/J
LJ1I VYV

SEPTEMBER 2020



69

Issue Management

Issues +

0000 Project (Training) Template

Q Search by # or issue text fields

#8 Training issue
To Robert Brown (DF..International Airport)

#7 Training
To Robert Brown (DF..International Airport)

#6 Test
Unassigned

#5 Activity #2
Unassigned

| OPEN 4

#4 Bad pour
To Robert Brown (DF..International Airport)

#3 Bad pour
To Breanna Brown (VRX)

#2 Wrong dist  Filters ==
Unassigned

L
.] Documents A Issues

Details Activity

Training issue

Training issue

The issue is now
closed in BIM360 > all
communication is
handled within Unifier port)

Due Date
Unscheduled

Location
Unspecified

Location details

Enter text

Owner
Breanna Brown

Checklists @ Sync “ Daily Logs

SEPTEMBER 2020

*e= More

M\IZ\A/J

L/

vy



Issue Notice

Location: DFW > Program > DCC > Project > Construction Management

Purpose

This BP is initiated by the QA Team to
provide notification to the CM Team
and tracks the status of any project

Issues.

Users

Inspectors, CM Team, Consultant,

Contractor

SEPTEMBER 2020

Notes

Suggested record title:

This replaces the current Non-Conformance
Report BP.

Issue Type Category & Root Cause Category
must be selected before Issue Type and Root
Cause.

Issue Type Category * Issue Type *
1‘ Select v ‘ 2‘ Select v ‘

Root Cause Category * Root Cause *
1‘ Select v ‘ 2‘ Select v ‘

If “Photos Included” is applicable/checked — add
attachments.

Attachments
vV Photos Included

b v
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Submt

Issue Notice

Workflow Notes: QA Inspector & EOR Review & Resolution Review optional

QA Inspector QA Inspector
Clarification Resolution
Review
A submit A | Submit
Rospanse Resgonse
Raturn for Raturn for Send for QA
Clarscanon Carscanon Respiution
Return fof QA | } Rewprw
Claificatcn Yy v v Send v
Construction Submit Tesue PRRACD Resolutian far Construction
- A | Cas
> Mgr. Initial 0 Contratiee > Raview Pprova > ¥or. 14
Review Resolution
Send lor FOR A | No Action Send for EOR | A
Reveaw Requited - Resolution Submit
Closixd Rayiew Response
EOR
Resolution
SUMI" | Review
Resonsa |
v |
EOR Initial
Review

Auto cc: Creator, Contractor & PM Team at End step

SEPTEMBER 2020

™
L/

\A/J
vy



MICA\A7J

——
L1 VY
DFW Airport System
QUALITY CONTROL PROGRAM
QUALITY DEFICIENCY REPORT
Project Name: Project Number:
(1) (@]
(3) Deficiency No: (4) (Sub)Contractor / Supplier: (5) Originator & Organization: (6) Date:
(CONTRACTOR)
(7) Deficiency Subject and Summary:
Specification Section || (8) Il Line Item # Il 9) Il Quantity Il (10)
(11) (CONTRACTOR)
Proposed Resolution:
(CONTRACTOR)
(12) Deficiency Area:
(Check One) DConcrete DAsphaIt
DSoiIs / Aggregates DOther
(CONTRACTOR)
(13) Disposition Status: [_] REJECT [ repar
(Check One)
| REWORK [] use-As-is
(DFW CM)
(14) CM Comments:
CM Approval of Resolution: DFW CM QA Dept. Acknowledgement of NCR:
(15) (16) (17) (18)
Signature Date Signature Date
(DFW CM)
(19) Quality Assurance verification that nonconforming condition has been corrected: (DFW QA Inspector)
(20) (21)
Construction Quality Inspector Date
DFW Quality Assurance Manager's Approval:
(22) (23) (24)
Print Name Signature Date
(DFW CM)
(25) Document Control Number:

12.0 Deficiency Report Example

February 2020


ymccollom
Stamp


IN\I[\A/J

L1 VY
Quality Deficiency Form Directions
*Reference numbers on the preceding Quality Deficiency Form marked "Example”. Follow the completion directions below.
Number Title: Directions
1 Project Name Enter Project Name
2 Project Number Enter Project Number
3 Deficiency No. Enter the Deficiency Number, also kept on Log
4 (Sub)Contractor / Supplier Enter the name of the Contractor or their Subcontractor that has committed the Deficient condition
5 Originator & Organization Enter the name of the Originator of the deficient condition (Can be the Owner or Contractor
6 Date Enter Date of Deficiency Report. Format month.day.year (i.e. 09.13.2018)
7 Deficiency Summary Summarize the deficient condition as concisely as possible
8 Specification Section Enter the Specification that the deficient condition is in violation
9 Line ltem# Enter the Line Item number associated with the deficient condition
10 Quantity Enter the affected quantity associated with the deficient condition
Enter the proposed resolution to mitigate the deficient condition. (This can be provided by the

1" Proposed Resolution Contractor QC)
12 Deficiency Area Check the box associated with the discipline of the deficient condition
13 Disposition Status Check the box associated with the disposition status of the deficient condition
14 CM Comments Provide comments on the disposition of the deficient condition's resolution
15 CM Signature Enter the CM signature

12.0 Deficiency Report Instructions February 2020



16

17

18

19

20

21

22

23

24

Date

QAM Signature

Date

Quality Assurance Verification
Construction Quality Inspector
Date

Print Name

Signature

Date

12.0 Deficiency Report Instructions

Enter Date of Signature. Format month.day.year (i.e. 09.13.2018)

Enter the QAM signature

Enter Date of Signature. Format month.day.year (i.e. 09.13.2018)

Provide rhetoric associated with verification that the deficient condition has been corrected
Enter the CQl signature

Enter Date of Signature. Format month.day.year (i.e. 09.13.2018)

Print the name of the QAM

Provide the signature of the QAM

Enter Date of Signature. Format month.day.year (i.e. 09.13.2018)

IN\I[\A/J

L1

Yy

February 2020
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DFW Airport System
QUALITY CONTROL PROGRAM
QUALITY DEFICIENCY REPORT
Project Name: Project Number:
Runway 13L/32R Runway Rehabilitaton OH6130.200.50.220
(3) Deficiency No: (4) (Sub)Contractor / Supplier: (5) Originator & Organization: (6) Date:
2 Reyes Group Jim Harbaugh 09.13.2018
(CONTRACTOR)
(7) Deficiency Subject and Summary:
The subcontractor, right way pipe, delivered a 60" RCP and during the installation a pipe joint was not driven home.
Speification Section || P-701 Il Line ltem # Il 140 Il Quantity II 15LF
(11) (CONTRACTOR)
Proposed Resolution:
The installation will be exposed, the pipe joint will have crack sealing applied to cover joint.
(CONTRACTOR)
(12) Deficiency Area:
(Check One) DConcrete I:lAsphalt
DSoiIs/Aggregates Other RCP pipe installation
(CONTRACTOR)
(13) Disposition Status: |:| REJECT |:| REPAIR
(Check One)
REWORK [] use-as-is
(DFW CM)
(14) CM Comments:
The resolution will be acceptable as long as the CM Inspector is present during the installation. Additional training will be
completed by the Contractor Quality Control MGR.
CM Approval of Resolution: DFW CM QA Dept. Acknowledgement of NCR:
(15) 09.13.2018 @an 09.14.2018
Signature Date Signature Date
(DFW CM)
(19) Quality Assurance verification that nonconforming condition has been corrected: (DFW QA Inspector)
The contractor applied the crack sealing, QC and QA were present and observed the workmanship of the application.
(20) 09.20.2018
Construction Quality Inspector Date
DFW Quality Assurance Manager's Approval:
William G, Smith (23) 09.26.2018
Print Name Signature Date
(DFW CM)
(25) Document Control Number: OH6130.200.50.220.K.16.C_DEF2
12.0 Deficiency Report Sample February 2020
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DFW Airport System
QUALITY CONTROL PROGRAM
QUALITY DEFICIENCY REPORT
Project Name: (1) Project Number: 2)
(3) Deficiency No: (4) (Sub)Contractor / Supplier: (5) Originator & Organization: (6) Date:
(CONTRACTOR)
(7) Deficiency Subject and Summary:
Specification Section || Il Line ltem # Il Il Quantity II
(11) (CONTRACTOR)
Proposed Resolution:
(CONTRACTOR)
(12) Deficiency Area:
(Check One) DConcrete I:lAsphalt
DSoiIs | Aggregates |:|Other
(CONTRACTOR)
(13) Disposition Status: |:| REJECT |:| REPAIR
(Check One)
O REWORK [ use-as-is
(DFW CM)
(14) CM Comments:
CM Approval of Resolution: DFW CM QA Dept. Acknowledgement of NCR:
Signature Date Signature Date
(DFW CM)
(19) Quality Assurance verification that nonconforming condition has been corrected: (DFW QA Inspector)
Construction Quality Inspector Date
DFW Quality Assurance Manager's Approval:
Print Name Signature Date
(DFW CM)
(25) Document Control Number:

12.0 Deficiency Report Blank

February 2020
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[Non-Conformance Report (NCR) Form NCR No. | (1)
Project No. (2) Project Name: (3) Date Inspected (4)
Specification Section No. (5) Location (6)
Contractor (7)
Activity (8)
THE CONTRACTOR IS REQUIRED TO RESPOND TO THIS NCR NO LATER THAN (9)
NO PAYMENT WILL BE AUTHORIZED FOR WORK DEEMED TO BE IN NON-CONFORMANCE WITH THE CONTRACT
UNTIL SUCH TIME AS YOUR CORRECTIVE ACTIONS HAVE BEEN SUBMITTED, APPROVED AND PERFORMED.
Description of Deficiency: (10)
Required Action: (i)
(12) (13)
DFW Construction Manager Representative Date

13.0 NCR Example February 2020
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[Non-Conformance Report (NCR) Form QDR NO. | (1) | Page2 |
Contractor Action: (14)
Contractor Action to Prevent Reoccurrence: (15)
(16) (17)
Contractor Representative Date Corrected
Designer/Engineer Comments: (18)
(19) (20)
Designer/Engineer Date
Verified: (21) (22)
DFW Quality Assurance Manager Date
(23) AcceptED [_| REJECTED[ | usepAsis [_|
FOR THE CONSIDERATION OF $ (24) . THIS NON-CONFORMANCE WORK WILL BE USED AS IS.
(25) (26)
Project Manager Date
Follow-Up Required: (27)
Verified: (28) (29)
DFW Quality Assurance Manager Date
Document Control No.: (30)

13.0 NCR Example February 2020



Non-Conformance Report (NCR) Form Directions

*Reference numbers on the preceding Non-Conformance Report (NCR) Form marked "Example". Follow the completion directions below.

Number

Title:

Directions

IN\I\A/
L/ VY

1

2

10

11

12

13

14

15

16

17

18

19

NCR No.

ProjectNo.

Project Name:

Date Inspected
Specification Section No.
Location

Contractor

Activity

Response Time
Description of Deficiency:
Required Action:

DFW Construction Manager
Representative

Date
ContractorAction:

Contractor Action to Prevent
Reoccurrence:

Contractor Representative

Date Corrected

Designer/Engineer Comments:

Designer/Engineer

13.0 NCR |Instructions

Enter the NCR number (Should be chronological per project)

Enter the Project number

Enter the project name

Enter the date item was inspected in format month.day.year (i.e. 09.13.2018)

Enter the Technical Specification violated

Enter the location of the non-conforming item (Be as concise as possible / Include drawings)

Enter the Contractor / Subcontractor responsible for the non-conforming condition

Enter the activity associated with the non-conforming condition

Enter the amount of time, in days, in which the Contractor is required to respond. (Usually 2 weeks)
Describe the non-conforming condition that has taken place (Be as concise as possible)

Describe the required action expected to be implemented to resolve the non-conforming situation

Enter the DFW Construction Manager signature
Enter the date signed in format month.day.year (i.e. 09.13.2018)

Describe, in depth, what the Contractor has completed to correct the non-conforming condition

Enter the Contractor's actions that they will take to eliminate reoccurrence of this non-conforming condition

Enter the Contractor Quality Control Manager's signature

Enter the date non-conforming work was corrected in format month.day.year (i.e. 09.13.2018)

If required, provide the Engineer of Record's concurrence to the corrective action taken by the Contractor, if

the EOR is not required, enter "N/A"

Enter the EOR signature

February 2020



20

21

22

23

24

25

26

27

28

29

30

Date
DFW Quality Assurance Manager
Date

Status Check Box

Dollar Penalty Amount

Project Manager

Date

Follow-Up Required:

DFW Quality Assurance Manager
Date

Document Control No.:

13.0 NCR |Instructions

Enter the date signed in format month.day.year (i.e. 09.13.2018)
Enter the DFW Quality Manager signature

Enter the date signed in format month.day.year (i.e. 09.13.2018)
Check the appropriate box

Enter the amount of the anticipated cost for the correction of the non-conforming condition (use dollar
assignment procedure contained in Appendix B)

Enter the Project Manager's signature

Enter the date signed in format month.day.year (i.e. 09.13.2018)

Describe the follow up action, if needed, to ensure compliance with the Contractor's proposed action
Enter the DFW Quality Manager signature

Enter the date signed in format month.day.year (i.e. 09.13.2018)

Enter the "Document Control" number for the non-conformance report (must be uniquely identified)

IN\I\A/
L/ VY

February 2020
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DFW Airport System

[Non-Conformance Report (NCR) Form NCR No.| 2

Project No. 200.20 Project Name: Runway 13L/32R Rehab. Date Inspected 09.13.2018

Specification Section No. P-152 Location Southeast Shoulder Embankment

Contractor, Jim's Excavating, Inc.

Activity Installation of embankment

THE CONTRACTOR IS REQUIRED TO RESPOND TO THIS NCR NO LATER THAN 09.30.2018

NO PAYMENT WILL BE AUTHORIZED FOR WORK DEEMED TO BE IN NON-CONFORMANCE WITH THE CONTRACT
UNTIL SUCH TIME AS YOUR CORRECTIVE ACTIONS HAVE BEEN SUBMITTED, APPROVED AND PERFORMED.

Description of Deficiency: The contractor failed to use the proper equipment. The approved equipment is only a

sheepsfoot roller meeting the requirements of the P-152 Specification. The contractor failed to use the proper equipment and failed

to have each lift tested in accordance with the specification.

Required Action: The Contractor will remove all embankment associated with this section, reinstall and recompact.

In addition, the Contractor will ensure that all QC testing is conducted and that DFW is informed so that we can witness the results.

(12) 09.13.2018
DFW Construction Manager Representative Date

13.0 NCR Sample February 2020
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[Non-Conformance Report (NCR) Form QDR NO. | 2 | Page2 |

Contractor Action: Jim's has removed the questionable embankment and recompacted using the proper equipment.

All testing was witnessed and passed in accordance with the P-152 specification.

Contractor Action to Prevent Reoccurrence: The Contractor Quality Control has held an additional pre-activity meeting and

has reminded the Superintendent of the proper equipment required per the P-152 and has ensured testing plans in agreement with the
Client.

(16) 09.20.2018
Contractor Representative Date Corrected

Designer/Engineer Comments: N/A

N/A N/A
Designer/Engineer Date
Verified: (21) 09.20.2018
DFW Quality Assurance Manager Date
(23) AccerteED [ | REJECTED[ | usepasis [_|
FOR THE CONSIDERATION OF $ 12,000 . THIS NON-CONFORMANCE WORK WILL BE USED AS IS.
(25) 09.25.2018
Project Manager Date

Follow-Up Required: No follow up action required. The QA witnessed the installation and has been provided a copy of the

meeting minutes form the additional pre-activity meeting.

Verified: (28) 09.28.2018
DFW Quality Assurance Manager Date
Document Control No.: OH3130.200.50.220.K.10.A 13L

13.0 NCR Sample February 2020
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DFW Airport System

[Non-Conformance Report (NCR) Form NCR No.|
Project No. Project Name: Date Inspected
Specification Section No. Location
Contractor
Activity

THE CONTRACTOR 1S REQUIRED TO RESPOND TO THIS NCR NO LATER THAN

NO PAYMENT WILL BE AUTHORIZED FOR

WORK DEEMED TO BE IN NON-CONFORMANCE WITH THE CONTRACT

UNTIL SUCH TIME AS YOUR CORRECTIVE ACTIONS HAVE BEEN SUBMITTED, APPROVED AND PERFORMED.

Description of Deficiency:

Required Action:

DFW Construction Manager Representative Date

13.0 NCR Blank February 2020
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[Non-Conformance Report (NCR) Form QDR NO. | | Page2 |
Contractor Action:
Contractor Action to Prevent Reoccurrence:
Contractor Representative Date Corrected
Designer/Engineer Comments:
Designer/Engineer Date
Verified:
DFW Quality Assurance Manager Date
ACCEPTED |:| REJECTEDl:I USED AS IS |:|
FOR THE CONSIDERATION OF $ , THIS NON-CONFORMANCE WORK WILL BE USED AS IS.
Project Manager Date
Follow-Up Required:
Verified:
DFW Quality Assurance Manager Date

Document Control No.:

13.0 NCR Blank February 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

3.1 AOA RADIO PROTOCOLS

Port 102 Airfield Duty Officer

Port 110 Airfield Duty Officer Assistant for East Side
Port 111 Airfield Duty Officer Assistant for West Side
Port 120 (All)  Airfield Agents

Port 135 DFW Maintenance Officer

Airport Operations Center: 972-973-3112
Operations Port 102 Office: 972-973-3121
Operations Port 102 Mobile: 972-948-7214
Operations Port 103 Mobile: 214-649-5017
Operations Port 110 Mobile: 972-948-2557
Operations Port 111 Mobile: 972-948-5528
Operations Port 135 Office: 972-973-3405

Contact Port 102 on AOA Primary Channel for:
e Boom Clearance Approvals
e Electrical Circuit Lockout Approvals
e Utility Disruptions

Contact Port 110 / 111 on AOA Primary Channel for:
e AOA Entrance Requests
e Man on Foot, with Flagman, Pull-Back Requests
e Airfield Closure Requests
e End of Day Inspections where construction activities were performed

Contact Operations on AOA Primary Channel for:
e Vehicle Escort Requests

Contact DFW Maintenance on Maintenance Primary Channel for:
e Requesting Maintenance for Electrical Circuit Lockouts / Unlock

Airfield Protocols Page 1 of 9 September 2020
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alpha
bravo
charlie
delta
echo
foxtrot
golf
hotel
india
juliet
Kilo
lima
mike

N <X XS<CcCcH®wW®XOHTO Z

november
oscar
papa
quebec
romeo
sierra
tango
uniform
victor
whiskey
X-ray
yankee
zulu

Airfield Protocols

Page 2 of 9

September 2020
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AIRFIELD PROTOCOLS

L1 VY

Listen before you transmit, especially if you have changed frequencies.
Verify the frequency is clear. No radio traffic is allowed during alerts until
DFW command has officially terminated the alert. The termination will be
broadcast over the radio at such time.

Know what you want to communicate prior to beginning your transmission.
Brevity is of utmost importance. Speak in your normal voice using clear,
concise terms. Wait a short while if you do not receive a quick response
before attempting to re-transmit.

References to time should be communicated in Military time.
(Example - 7:00 p.m. is 19:00)

Proper Aviation phraseology should be utilized.

Call Phrase

Translation

Wilco

Roger
Affirmative
Negative
Acknowledge
Correction

Go Ahead

Hold or Hold Position
Stand By
Say Again

"l will comply."

"l have received and understood your last transmission."
"Yes."

"No."

"l received and understand your transmission."

An error within the transmission was made and corrected
version follows.

Proceed with your transmission.
This phrase is not to be used for any other purpose.

Stay in place at current location.
Wait for further communication.

Repeat last radio transmission.

Airfield Protocols

Page 3 of 9 September 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

Example:

“111, [Your Call Sign] .... Requesting entry for myself and the FY-17 Pavement
Rehab contractor at AOA Gate # 308, we will be working on the W/K Closure.”

Example:

Operations, [Your Call Sign] ...... Project 473 is requesting escort for 5
vehicles from AOA Gate #308 to the taxiway W/K Closure.”

If it’s a round trip escort request, inform Operations that it will be a round trip.

Example:

“102, [Your Call Sign] ...... The taxiway W/F Contractor is requesting a 35’
boom clearance at taxiway W/K worksite. The equipment will be flagged /
lighted.” (Flagged for Dayshift / Red Light for Nightshift).

Be prepared to inform Port 102 of exact location of boom being raised.

Example:

“The boom will be located approximately 60 feet east of the taxiway Foxtrot
centerline and approx. 130 feet south of the Whiskey-Kilo Centerline, with a
height of 26 for a duration of three hours “

Inform Port 102 when the boom is down, and activities are completed.

Airfield Protocols Page 4 of 9 September 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

First:
Example:

“102, ( Your Call Sign)....... The FY12 Pavement Rehab contractor is
requesting to lockout 7 electrical circuits at the Southwest Lighting
Vault.”

Second:
Example: Noted for Escort Requests

Request DFW Operations Escort from your location to the Lighting Vault
for yourself and the contractor’s electrician. (Usually 2 Vehicles)

Third:
After arriving at the Lighting Vault.... Call 135 on Maintenance Primary
Channel and request assistance with circuit lockouts at the vault.

After all circuits have been locked out of service, Inform Port 102 that all circuits
are out of service.

After all circuits have been returned to service, Inform Port 102 that all circuits
have been returned to service.

When construction activities are completed, & the contractor requests to return
the circuits back in service. Request escort to the vault & Call Port 135 again on
Maintenance Primary to request assistance with returning circuits to service.

Remember to switch your radio channel back to Ops Primary after conversing
with Port 135 on DFW Maintenance Primary channel.

There are 3 Lighting Vaults @ DFW Airport:

West Airfield:
1. SW Lighting Vault
East Airfield:
2. NE Lighting Vault
3. East Lighting Vault

Airfield Protocols Page 5 of 9 September 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

3.2 MINIMUM STANDARDS FOR CONSTRUCTION AND MAINTENANCE ON THE
AOA

o Verify Safety Briefings are held prior to each shift, and attendance recorded.

e Obtain Safety Briefing and AOA Checklist documentation prior to AOA entry.

e Verify the correct information was provided on daily Airfield Closure Requests prior
to requesting closures through DFW Operations, to avoid delays.

o Verify FAA approved height restrictions for each area prior to requesting a boom
clearance. Verify boom clearances for construction equipment and request approval
from DFW Operations Port 102 prior to raising boom. Inform DFW Operations when
boom operation is completed.

o Verify all lighted safety cones / PVC barricades are in place within airfield closures
perimeter areas and verify that Lighted X’s for runway closures are all fully
operational.

o Verify electrical circuit lockouts requested by the contractor are correct for the area
prior to excavations being performed. (See Electrical Circuit Lockout procedure
below and AOA Radio Protocols.)

o Verify airfield signage / lighting obliterations are in-place and maintained per C-139
requirements.

o Verify artificial lighting is in place during nightshift activities for each work area.

o Verify escorting rally flags and amber rally safety lighting are maintained / utilized.

o Verify the location / install / maintenance of runway & taxiway placards noting
specified haul routes, runway & taxiway safety areas, and runway & taxiway object
free areas (OFA).

e No construction activities allowed within taxiway / taxilane OFA (pending DFW
Operations’ approval on a case-by-case basis.)

e Verify FOD issues within closure & adjacent areas (Aircraft Safety).

e Verify all food / lunch items are not left within work areas (Aircraft / Wildlife Safety).

e Verify scheduled construction activities with prime contractor prior to entering the
AOA. A prime contractor representative must accompany all subcontractors onto the
airfield.

e Verify all construction activities and affected areas comply with the approved plans
and specifications prior to beginning.

o Verify that the actual activities being performed conform with the scheduled/planned
activities.

o Verify the contractor’s QC representative is on-site for construction quality
verifications throughout the workday.

e Verify the contractor’s safety representative is on-site performing safety duties.

e Verify all contractor representatives have all required PPE for construction safety.

Airfield Protocols Page 6 of 9 September 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

o Verify Material Submittals / RFI's / Change Order / Plan Page Redesign items.
e Verify Change Order item requirements with QC prior to official submittal to DFW
Airport.

o Verify all representatives entering the AOA are badged and/or properly escorted and
that escorting of persons / vehicles meets required ratios.

o Verify that NO equipment is stored within 10 feet of AOA perimeter fencing & nothing
is delivered over, under, or through an AOA perimeter fence.

e Verify all vehicles / haul trucks / equipment entering the AOA have a lighted safety
beacon and/or 3’ x 3’ safety flagging.

o Verify all vehicles entering the AOA have company identification / logo on both sides
of the vehicle.

o Verify all vehicles entering the AOA have a valid AOA access permit on both
bumpers.

e Coordinate / request / verify Pull Back procedures within open taxiway safety / object
free areas.

¢ ARFF Road traffic for emergency vehicles must be provided at all times. A
temporary detour may be constructed.

e Verify all vehicles / equipment / representatives remain in designated areas.

e Request airfield escorting via DFW Operations for all vehicle movement outside of
the airfield closure.

e Prior to hauling for the 15! time, document existing conditions adjacent / within work
area to document possible existing damage.

e Coordinate / request / verify contractor’s Flagman Protocols for open airfield areas.

e CMAE Training is required for vehicle traffic flag men / flag women.

e CMAE training is required for all contractor representatives who provide escorting
via the project haul route.

o Verify all utilities within the area are located / noted prior to excavations or
demolitions (Dig-Book).

e Deactivation of existing utilities (water, power, etc.) must be coordinated.

e All excavations within &’ of existing utilities must be done by hand or vacuum
extraction methods.

e |If existing cables / utilities are damaged, inform Port 102 & if a cable was damaged,
fill out cable cut sheet to attach to daily report.

Airfield Protocols Page 7 of 9 September 2020
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3.0 AIRFIELD PROTOCOLS L1 VY

e Verify materials with the approved material submittal prior to install.

o Verify QA & QC material testing firms have performed the required testing and the
results comply with the project requirements / specifications.

e Verify material installations / daily quantities with the contractor’'s QC representative.

e Verify all soil / equipment / material stockpiles within the AOA have a perimeter
encompassed by lighted safety cones and/or lighted barricades and are maintained
to a specified height (maximum 3 feet, typical).

e Verify that DFW Code Enforcement has approved the area / material prior to final
construction being performed.

e Verify SWPPP compliance, including contractor’s inspection of work areas and
documentation of protection of materials on site.

o Verify all oil / grease / fluid spills are contained and / or cleaned up and notify DFW
Operations of spills that have or could potentially affect soils or storm drains.

e Verify the contactor has a spill kit on-site for SWPPP issues / emergencies.

e Dust Control measures must be taken at all times.

o Keep vegetation @ 8" height maximum (mow within work area).

1. Request lockouts via DFW Operations Port 102 (AOA Radio Channel OPS
Primary). See AOA Radio Protocols for circuit lockout procedures.

2. Request DFW Maintenance to arrive at one of three Lighting Vaults for lockouts
(AOA Radio Channel Maintenance Primary)

a. Three Lighting Vaults: NE, SW, E

3. Request escort for inspector / contractor’s electrician to corresponding electrical
lighting vault.

4. Verify airfield lighting / signage circuits are the circuits requested by the contractor
to be inhibited.

5. Verify electrical megger reading for each individual electrical circuit prior to lockout.

6. Verify alock is on each circuit switch box to prevent others from re-energizing
circuit.

7. Verify S-1 switch has been removed from each circuit box to prevent re-energizing
of circuit by others.

8. Sign DFW Maintenance documentation which verifies electrical circuit reading prior
to lockouts.

9. Verify electrical regulator is shut down prior to exiting electrical vault.

10. Inform DFW Operations that the requested electrical circuits are inhibited.

11. Request escort for inspector / contractor electrician back to work area.

12. DFW Inspector needs to be aware of who to inform if the following issues arise:

Airfield Protocols Page 8 of 9 September 2020



IN\[\A/

3.0 AIRFIELD PROTOCOLS L1 VY

Megger reading is not satisfactory.
Electrical Regulator has issues.

Electrical Circuit does not have Continuity
Electrical components / system damaged.

oo ow

Object Free Area (OFA) and Safety Area Dimensions

e Runway OFA = 800’ wide @ 400’ either side of runway

¢ Runway Safety Area (RSA) = 500’ wide @ 250’ either side of runway and 1000’ from
end

e Taxiway OFA =160’ or 193’ from Taxiway Centerline (193’ for Group 6)

e Taxiway Safety Area (TSA) =107’ or 131’ from Taxiway Centerline (131’ for Group
6)

3.3 ATTACHMENTS

NONE

Airfield Protocols Page 9 of 9 September 2020



IN\[\A/

4.0 CONTRACTOR QUALITY CONTROL L1 VY
REQUIREMENTS

41 CONTRACTOR QUALITY CONTROL PROGRAM

Contract Documents: Plans and Specifications, General Provisions, General and Special
Conditions and other Division 01 Specification Sections apply to this Section.

This Section identifies the Quality Control activities to be performed during all phases of the
Contract by the Contractor.

The Contractor must have in place a Quality Control Program as necessary to ensure that all
materials and work are completed in compliance with Contract Documents. The Contractor is
solely responsible for Quality Control and must provide the necessary QC personnel to assure
that all materials, workmanship, and tests are in conformance with the Contract Documents.

Test schedules and/or testing requirements for materials used on this project are included in the
Contract Documents. Laboratory and field-testing identified in the specifications must be
conducted by a Testing Agency retained by the Contractor; hereafter is referred to as the
Materials Testing Agency (MTA).

DFW or its consultant working as the airport’s agent will employ a testing agency to perform
Quality Assurance and/or Special Inspection Testing of material and Inspection of workmanship
required. The Contractor must schedule these tests and provide access to the DFW agents’
inspectors and testers to perform these tests and inspections. The performance of the tests by
DFW does not relieve the Contractor of the responsibility to meet all the requirements of the
Contract Documents.

4.2 CONTRACTOR SUBMITTAL REQUIREMENTS

Within ten (10) days after Notice to Proceed, the Contractor must submit a project specific Quality
Control Plan for review and acceptance. The Quality Control Plan must be accepted by DFW
Quality Assurance Manager prior to any Work or materials being incorporated into the Project.
Acceptance by DFW Quality Assurance Manager does not relieve the Contractor of its
responsibility to comply with the Contract Requirements. The Contractor Quality Control Plan
must include the following at a minimum:

A general description of Quality Control monitoring to be
performed until final acceptance by DFW. Include monitoring of all activities of Work and
monitoring the work site as necessary for safety, security, and protection of the work during
times that no construction activity is scheduled to take place.

No work shall take place without QC staff on site.

An individual designated by the Contractor and approved in writing the DFW
Quality Assurance Manager whose [sole] responsibility is Quality Control Management.
This individual must be highly qualified in all phases of construction as it relates to this
Project and must have the authority to direct work changes required to bring the Work into
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4.0 CONTRACTOR QUALITY CONTROL L1 VY
REQUIREMENTS

conformance with Contract requirements, including stopping non-conforming work in
progress. A detailed resume of the proposed Quality Control Manager including applicable
education, experience, and certifications must be included in the Quality Control Plan.

Provide Quality Control inspection staff as needed to assist the
Quality Control Manager with implementation of the Quality Control Program. Duties of
the Quality Control Manager and Inspectors must be limited strictly to inspection of the
ongoing work. Sampling and testing of materials must be performed by Quality Control
personnel other than Quality Control Inspectors. Quality Control Inspectors must inspect
only those work elements for which they are qualified. Resumes of the proposed Quality
Control Inspectors including applicable education, experience, and certifications must be
included in the Quality Control Plan.

An Organization Chart identifying all Quality Control staff by name
and function. The chart must indicate the total staff required to implement all elements of
the Quality Control Program, including inspection and testing for each item of work
including tests performed by the MTA. If necessary, different Quality Control staff can be
utilized for specific inspection and testing functions for different items of work. The chart
must show that the Quality Control Manager, Quality Control Inspectors, and Quality
Control testing personnel are not production staff with clear lines of authority for Quality
Control outside the production staff.

The Contractor’s testing and inspection must be performed
for the processing, preparation and to request DFW code inspection and as necessary to
produce the required product as specified in the Contract Documents. The Contractor
must meet the minimum inspection and testing frequencies specified in the contract
documents. When the contract documents do not specify minimum inspection and testing
frequency the Contractor must propose in writing to the DFW Quality Assurance Manager
QC inspection and testing frequencies that meet or exceed industry standards for the
material and work being placed or conducted.

» Any test performed by any agency on the Project must be recorded and show a
passing re-test of all failing tests.

» All test results must be made available for inspection by the DFW Project Manager.
This includes tests that are above the QC testing frequency required.

» Any tests submitted by the Contractor for basis of acceptance, must meet all
standards and must be certified to have followed approved procedure, processed
in a certified lab by properly certified or licensed personnel by properly certified
testers and on calibrated and certified equipment. All tests must be recorded in the
field witnessed by a DFW inspector to be accepted as a record test of the material
in question. Any failing tests could be the sole basis for rejecting the material.

QC Plan must meet each technical specification division’s requirements for quality control,
identifying each item requiring submittal and approval/acceptance prior to installation of
work.
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The Contractor must keep track of all logs of deficiencies and submit periodic updates, as
required by the Contract Documents, of all open issues and track the closure.

The QC Manager must establish a deficiency list to include the following information for
each item: description, date, location, drawings reference, detail reference, specification
reference, superseding NCR document, date of expected solution, date repaired, date
inspected by DFW representative and accepted.

The Contractor must not change or alter approved submittals, procedures, specifications,
drawings/MODELS, or other pertinent documentation without the DFW Project Manager's written
authorization.

All records and documents that are quality related must be prepared, identified and maintained
by the Contractor and must be made available to DFW upon request. Records must be protected
from damage, deterioration, or loss. A copy of the records and documents must always be
maintained at the Work site unless the DFW Project Manager has approved other locations in
writing

The Contractor must maintain records at the actual worksite and at Contractor's office to show
the inspection status of materials and items installed to ensure that the required inspections and
tests have been performed per the contract documents.

The Contractor must keep a record of all deficiency issues and show positive evidence of closure
(passing re-inspection or re-test) to every issue.

4.3 INSPECTIONS AND TESTS

Inspections, tests and system shut down requests, conducted by persons or agencies other than
the Contractor, must not in any way relieve the Contractor of the responsibility and obligation to
meet all specifications and the referenced standards.

The Contractor's designated Quality Control Representative must inspect the work and must
ensure the Work complies with the Contract requirements prior to any requests for Code
inspection or testing.

4.4 PHASES OF QUALITY CONTROL

The Preparatory Phase occurs usually days or weeks in advance, before you begin each
construction task or DFOW. For this phase, the superintendent should do the following:

o Review all the requirements for the task

e Assess the current situation

¢ Inspect the jobsite

e Review the findings with staff, subcontractors, and the client
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PHASE 2: INITIAL PHASE

The Initial Phase occurs just prior to giving the go-ahead to begin work and ensures that the task

will start correctly. For this phase, the site supervisor should do the following:

e Check that all requirements for personnel, materials, and equipment are in place

o Verify that the site has passed its job-ready inspection

¢ Inspect the first article (after work begins) to make sure that it is appropriate to continue
work

PHASE 3: FOLLOW-UP PHASE

The Follow-Up Phase occurs throughout the construction task. For this phase, the site supervisor
should do the following:

¢ Monitor work daily to assure that all job requirements are being met in a timely manner

o Verify that the tasks or DFOW are being performed correctly up until their completion

4.5 ATTACHMENTS
NONE
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5.1 PURPOSE AND OVERVIEW

This procedure establishes the process to document that selected contract materials have been
tested and/or inspected in accordance with established minimum standards. Such inspection
and/or testing should be performed prior to material delivery, acceptance and/or installation, as
appropriate. The objective is to create a keystone record document, which supports payment of
the final quantities.

The procedure for Scheduling of Material Testing will be done via a new Unifier Business
Procedure (BP). This procedure is initiated by the Contractor to schedule materials testing from
the Testing Agency and track test results. The Contractor is responsible for completing the Test
Schedule Request section, and the Testing Agency will complete the Tests Performed section.

See Attachment: Unifier BP Summary for Material Testing.

CM and QA Manager determine which materials are to be inspected

¢ QA Manager provides the Request for Inspection of Material (RFIM) forms to the Contractor.
CM Team reviews and verifies the submitted RFIM forms and backup documentation and
maintains the Quantity Book.

¢ QA Inspectors inspect all material for compliance with Contract Documents as it is brought on
site, or at a minimum, as it is being installed.

5.2 SCHEDULING OF MATERIAL TESTING FOR OWNER AND CONTRACTOR

Material Testing requests by the Contractor will be submitted through Unifier. See Attachment:
Unifier BP Summary for Material Testing for the DFW business process. Below is a summary of
the procedure in Unifier.

In Unifier, add the Mitigation Number from the provided list that pertains to the Project.
Under the Construction Management Folder, select the Material Testing tab.

CREATE a new entry and fill in the Title, Project Location, Specific Test Location. Then
go to Schedule Details tab.

Select ADD to enter scheduling information.

Input the requested Date/Time of the Test and then select SEND to complete the request.

Material Testing and Inspection Requests Page 1 of 3 September 2020
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M™ICAAS
L1 VYV

1. Click the Material Testing Link
2. Next click Create

| 3. New Window Opens

4. Next Slide

Create New Material Testing

See Attachment: Unifier Material Testing Contractor Request for complete instructions.

5.3 REQUEST FOR INSPECTION OF MATERIAL (RFIM)

1.

The CM Team shall set up and maintain a Quantity Book for each project, which may be a
section of the Project Book at the discretion of the CM Team. The Quantity Book will contain
the Quantity Book Sheets, RFIMs and Material Inspection Reports. Additional information
about the Quantity Book content, format, etc. may be found in the CM Manual.

The RFIM will be used to document details about select materials, and to request inspection
of those materials by DCC project personnel prior to installation.

The Construction Manager, together with the QA Manager, shall determine which material(s)
are to be inspected prior to installation. To the extent practical this shall be done prior to
Contractor mobilization, but may be done once work has begun as necessary;

The QA Manager will provide the Contractor with the RFIM form, along with the initial list of
materials requiring inspection, at the time of the Pre-Construction Meeting;

For each material that the CM Team/QA Manager determines requires inspection, the
Contractor shall complete an RFIM and submit it to the CM Team. Such submittal by the
Contractor must be made far enough in advance to allow sufficient time for inspection of the
material(s);

On a project-specific basis, the CM Team may then either:

Request that the QA Manager assign a QA Inspector to pre-inspect the material(s) off-
site prior to delivery or consumption; or

Notify the QA Manager or assigned QA Inspector to inspect the material(s) upon delivery
to the job site.

Material Testing and Inspection Requests Page 2 of 3 September 2020



IN\[\A/

5.0 MATERIAL TESTING AND INSPECTION REQUESTS =1 V¥

The Contractor will complete the RFIM, gather the appropriate back-up that goes with it, and
submit the entire package to the CM Team. Acceptable back up could be delivery tickets,
certifications, etc.

The CM Team will review the package and verify that all appropriate back-up documentation
is included.

The QA Inspector will inspect the material(s), either off-site prior to delivery or on-site upon
delivery, and complete the necessary IDR(s).

Once delivery is complete and all documentation has been properly submitted, the CM Team

will match the IDRs with the RFIM package to verify final quantities. Additional documentation

the CM Team may review include:

o Request for Inspection of Materials

e Material delivery tickets and truck manifests (bound with adding machine tape and
identification)

e Material and equipment certifications, etc., submitted by Contractor.

Once satisfied that all documentation matches the CM Team will sign and return a copy of the

RFIM to the Contractor as confirmation.

Quantity entries, RFIMs references and other information will be recorded in the Quantity Book
by the CM Team.

Once an IDR has been completed and corresponding approved RFIM with back-up, that
material is eligible for payment. No payment will be made for materials without an approved
RFIM.

5.4 ATTACHMENTS
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The PowerPoint provides information how to request
the owner’s material testing within the Unifier
System.

Technical Specifications 01 45 16.13
Spec 3.3 Section E. Activities paragraph 3.

Contractor is to arrange for all testing and retesting of
work with the Owner’s Materials Testing Agency and
the Contractor’s testing laboratory.

Unifier/Oracle is the official record for documents.

NEXT SLIDE
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1. After Logging in Unifier.

2. See the attached mitigation Unifier Project Numbers
Click the + sign and enter the Project Number.

4. Next Slide
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S

Complete the * information on the
details section. You will have three
locations that are required prior to moving
forward.

Next click Schedule Details

See Next Slide
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3.

In the previous slide you clicked
schedule details.
Next complete the form requests

below. Make sure all the Red * areas
are completed. This page will allow
you to update the time, number of
tests, additional comments and the
type of testing needed.

You must save prior to clicking send.
+

After you complete the request go to
NEXT SLIDE
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Next, click send.
If the red occurs beside the send

button after completing either the
details page or the schedule details
page. A field required was not
completed. Scroll down and find

the red X and complete.

Next, when you send this form
make sure to include the
construction manager and
construction coordinator with the
request. Demetric Larry and
Rodney Stone will receive every
request sent in.

Next Slide
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Rodney Stone

817-705-7760

Senior QA Inspector/Manager
rstonel@dfwairport.com

Rodney Stone provides communication with the
DFW Airport Approved Acceptance Lab. Feel free
to contact me if you have questions or concerns
with material testing.
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DFW Airport System
Request for Inspection of Materials
Submit to: Project: DATE: (2)
DFW Design, Code & Construction
3003 S. Service Rd (1)
DFW Airport, TX 75261
General Contractor:
Construction Manager (3)
The following material may be inspected at: (4)
Telephone No: (5) Location on or after: (6)
Quantity & Description Line ltem # Spec. Item No. or Submittal No. and
Units P Drawing No. Status*

) 8) ©) (10) (11)

*Submittal Status: A - No Exception, B - Exceptions-as-Noted, C - Revise & Resubmit, D - Rejected, E - No Action Taken

Contractor/Supplier Certification
| hereby certify that the items listed above to be used in the construction of the subject project comply with all contract
requirements.

Company Name and Address: Certified by - Contractor/Supplier
(12) Name: (13)
Title: (14)

Construction Manager

Accepted by: (15) (16)
Construction Coordinator Date
Approved by: (17) (18)
Construction Manager Date

Inspection Report No.: | (19)

9.0 Request for Inspection of Materials Example September 2020
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Request for Inspection of Materials Instructions
*Reference numbers on the preceding RFIM Form marked "Example”. Follow the completion instructions below.
Number Title: Directions

1 Project List the project Name and number

2 Date Enter the date for the form's creation format month.day.year (i.e. 09.13.2018)

3 General Contractor Enter the name of the General Contractor

4 Location of inspection Enter the location of the inspection

5 Telephone Number Enter the contact phone number for the Contractor's representative

6 Location on or after Enter the date and time at which the material will be present for inspection

7 Quantity & Units Enter the Quantity and units of what is to be inspected

8 Description Enter the description of the material to be inspected

Enter the Line Item number for the material or the applicable Line Item for which it will be installed as

9 Line ltem# part of.

10 Spec. Item No. or Drawing No. Enter the specification section or page drawing number for the contract documents

11 Submittal No. & Status Enter the submittal number and the status using the guide in the middle of the page

12 Company Name and Address Enter the company name and address for whom is supplying the material

13 Name Enter the name of the contact person's name for the Contractor or Supplier

14 Title Enter the contact person's title

15 Construction Coordinator Enter the signature of the Construction Coordinator or the applicable person (Signature)

16 Date Received Enter the date that the form was signed

17 Construction Manager Enter the name of the Construction Manager (Signature)

18 Date Enter the date that the form was signed

19 Inspection Report No.: Enter the report number to coincide with the Quantity Book entry for "Evidence of Material Inspection"

9.0 Request for Inspection of Materials Instructions September 2020
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DFW Airport System
Request for Inspection of Materials
Submit to: Project: DATE: 09.13.2018
DFW Design, Code & Construction
3003 S. Service Rd Runway 13L/32R Runway Rehabilitation
DFW Airport, TX 75261
General Contractor:
Construction Manager Kiewit / Reyes, JV
The following material may be inspected at: 30" RCP, Class 1V Pipe
Telephone No: 373.259.3674 Location on or after:  South Staging Lot / 3:00PM
Quantity & s . Spec. Item No. or Submittal No. and
Units Description Line ltem # Drawing No. Status*
150 30" RCP, Class IV Pipe 12 P-701 A

*Submittal Status: A - No Exception, B - Exceptions-as-Noted, C - Revise & Resubmit, D - Rejected, E - No Action Taken

Contractor/Supplier Certification
| hereby certify that the items listed above to be used in the construction of the subject project comply with all contract
requirements.

Company Name and Address: Certified by - Contractor/Supplier
1520 Parker Road, Grand Prairie, TX 75050 Name: John Q. Public
Title: Superintendent

Construction Manager

Accepted by: (15) (16)
Construction Coordinator Date
Approved by: (17) (18)
Construction Manager Date

Inspection Report No.: | 12-01

9.0 Request for Inspection of Materials Sample September 2020
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Request for Inspection of Materials
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L/ VYV

Submit to:

DFW Design, Code & Construction
3003 S. Service Rd

DFW Airport, TX 75261

Construction Manager

Project:

DATE:

General Contractor:

The following material may be inspected at:

Telephone No:

Location on or after:

Quantity &
Units

Description

Line Item #

Spec. Item No. or
Drawing No.

Submittal No. and
Status*

*Submittal Status: A - No Exception, B - Exceptions-as-Noted, C - Revise & Resubmit, D - Rejected, E - No Action Taken

Contractor/Supplier Certification

| hereby certify that the items listed above to be used in the construction of the subject project comply with all contract

requirements.

Company Name and Address:

Certified by - Contractor/Supplier

Name:

Title:

Construction Manager

Accepted by:

Approved by:

Construction Coordinator

Date

Construction Manager

Date

Inspection Report No.:

9.0 Request for Inspection of Materials Blank

September 2020



IN\[\A/

6.0 LABOR INTERVIEW PROCESS (FORM 1445) kA

6.1 LABOR INTERVIEW REQUIREMENTS

The QA Inspection staff must follow these guidelines to ensure that Labor Standards Interview
forms are complete and accurate. Labor Interview Forms must be complete and accurate prior
to submittal.

e Allinspectors will be trained and will continue to be trained monthly on the appropriate way
to conduct Labor Standard Interviews and how to complete Standard Form 1445.

¢ QA Management staff will perform training for all new Inspectors hired.

e Monthly training sessions will be conducted for the QA Inspection staff.

¢ QA Inspectors will sign in and the training will be documented.

6.2 LABORINTERVIEW PROCESS

Interview request will be submitted to the QA team for scheduling.

Inspector will be scheduled accordingly.

Inspector will perform interview as scheduled.

Inspector will upload completed form to Unifier as an attachment.

Inspector will submit completed Standard Form 1445 to the QA Management team for
review on the day interview was performed. (No exceptions. Form must be submitted upon
completion of interview).

e QA Management will review the completed Standard Form 1445 for discrepancies. (No
blank boxes).

e QA Management may return the form to inspector for revisions or submit completed form to
Certified Payroll Processor for verification and processing.

6.3 ATTACHMENTS

Labor Interview Process (Form 1445) Page 1 of 1 September 2020



LABOR STANDARDS INTERVIEW

CONTRACT NUMBER EMPLOYEE INFORMATION
LAST NAME FIRST NAME Ml

NAME OF PRIME CONTRACTOR

STREET ADDRESS

NAME OF EMPLOYER

CITY STATE ZIP CODE

SUPERVISOR'S NAME
LAST NAME FIRST NAME Ml WORK CLASSIFICATION WAGE RATE

CHECK BELOW
ACTION YES NO

Do you work over 8 hours per day?

Do you work over 40 hours per week?

Are you paid at least time and a half for overtime hours?

Are you receiving any cash payments for fringe benefits required by the posted wage determination decision?

WHAT DEDUCTIONS OTHER THAN TAXES AND SOCIAL SECURITY ARE MADE FROM YOUR PAY?

HOW MANY HOURS DID YOU WORK ON YOUR LAST WORK DAY BEFORE TOOLS YOU USE
THIS INTERVIEW?

DATE OF LAST WORK DAY BEFORE INTERVIEW (YYMMDD)

DATE YOU BEGAN WORK ON THIS PROJECT (YYMMDD)

THE ABOVE IS CORRECT TO THE BEST OF MY KNOWLEDGE
EMPLOYEE'S SIGNATURE DATE (YYMMDD)

SIGNATURE TYPED OR PRINTED NAME DATE (YYMMDD)
INTERVIEWER

INTERVIEWER'S COMMENTS
WORK EMPLOYEE WAS DOING WHEN INTERVIEWED ACTION (If explanation is needed, use comments section) YES NO

IS EMPLOYEE PROPERLY CLASSIFIED AND PAID?

ARE WAGE RATES AND POSTERS DISPLAYED?

FOR USE BY PAYROLL CHECKER
IS ABOVE INFORMATION IN AGREEMENT WITH PAYROLL DATA?

D YES D NO

COMMENTS
CHECKER

LAST NAME FIRST NAME MI JOB TITLE

SIGNATURE DATE (YYMMDD)

AUTHORIZED FOR LOCAL REPRODUCTION STANDARD FORM 1445 (Rev. 12-96)

Previous edition not usable Prescribed by GSA - FAR (48 CFR) 53.222(g)



LABOR STANDARDS INTERVIEW

CONTRACT NUMBER

EMPLOYEE INFORMATION

9500xxx (xxx will be your project #) LAST NAME FIRST NAME Mi
NAME OF PRIME CONTRACTOR Good Johnny B

Flatiron Construction (Main Contractor) STREET ADDRESS
NAME OF EMPLOYER 123 Darlington Street

EAS Contractors (Sub Contractor) cITy STATE  (ZIP CODE

SUPERVISOR'S NAME Arlington TX 76001
LAST NAME FIRST NAME Ml |WORK CLASSIFICATION WAGE RATE
Smith JOE G | Concrete Finisher S 15080
CHECK BELOW
ACTIO
R YES NO

Do you work over 8 hours per day? 7
Do you work over 40 hours per week?
Are you paid at least time and a half for overtime hours?
Are you receiving any cash payments for fringe benefits required by the posted wage determination decision? F

WHAT DEDUCTIONS OTHER THAN TAXES AND SOCIAL SECURITY ARE MADE FROM YOUR PAY?

Child Support & Health Insurance

HOW MANY HOURS DID YOU WORK ON YOUR LAST WORK DAY BEFORE

TOOLS YOU USE

THIS INTERVIEW?

9

Brushes & Trowels

DATE OF LAST WORK DAY BEFORE INTERVIEW (YYMMDD)
200110

DATE YOU BEGAN WORK ON THIS PROJECT (YYMMDD)
190714

THE ABOVE IS CORBECT TO

THE BEST OF MY KNOWLEDGE

EMPLOYEE'S SIGNATURE DATE (YYMMDD)
;W O : 5 200114
SIGNATURE ~ . L TYPED OR PRINTED NAME DATE (YYMMDD]
INTERVIEWER P -
\.M 597’1 LM Intervierer's Name 200114
o INTERVIEWER'S COMMENTS
WORK EMPLOYEE WAS DOING WHEN INTERVIEWED ACTION (if explanation is needed, use comments section) YES NO
3 L} 5 " 3 1 1 1
Performing “Final" finishing on TWY Mike pour. IS EMPLOYEE PROPERLY CLASSIFIED AND PAID? 7
ARE WAGE RATES AND POSTERS DISPLAYED? 7

FOR USE BY PAYROLL CHECKER

IS ABOVE INFORMATION IN AGREEMENT WITH PAYROLL DATA?

L ves [Jno

COMMENTS

CHECKER

LAST NAME FIRST NAME

Mi JOB TITLE

SIGNATURE

DATE (YYMMDD)

AUTHORIZED FOR LOCAL REPRODUCTION
Previous edition not usable

STANDARD FORM 1445 (REV. 12-96)
Prescribed by GSA - FAR {48 CFR) 53.222(g)
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7.0 OFF-HOURS WORK PROTOCOL L/ YV

7.1 PURPOSE AND OVERVIEW

The procedure provides direction for effectively utilizing staff resources for inspection coverage
for work performed during off-hours, typically overnight or on weekends to minimize disruption of
DFW Airport Operations.

The QA Manager, in coordination with the CM Team, will schedule the required QA Inspector(s)
in advance of the planned off-hours work.

The QA Inspector’s responsibilities during off-hours work will vary slightly from day shift, in that
additional communication is required with the Contractor, DFW Operations, and Senior level staff
members.

The most significant difference between normal and off-hours work is that the CM Team may not
be as readily available to respond to a question or urgent issue from the Contractor or QA
Inspector. For this reason, it is the responsibility of the QA Inspector to have a clear
understanding of the proper communication and decision-making protocols to be followed during
off-hours work.

All work inside aircraft movement areas on the airfield must be coordinated through and approved
by DFW Operations prior to proceeding with the work. All areas must be cleared and re-opened
to air traffic no later than the approved and agreed-to time per the pre-activity meeting held by the
Contractor. See Airfield Inspector Daily Protocols for proper Radio and other Contact protocols.

7.2 OFF-HOURS WORK PROCESS

To the extent possible, the QA Inspector assigned to off-hours work should meet with, or
otherwise communicate with, the CM Team and/or the previous QA Inspector for the project,
to be briefed on any issues or concerns;

Likewise, the CM Team and other QA Inspectors should make additional efforts to ensure that
the off-hours QA Inspector is fully briefed on any project issues or concerns, and is aware of
any communication or decision-making protocols to be followed should a situation arise during
off-hours;

The off-hours QA Inspector should obtain contact information for all individuals or entities that
may need to be contacted if an issue arises during off-hours. This list should include, at a
minimum, contact information for the following:

Construction Manager and Construction Coordinators
Project Manager and Civil Team Program Director
QA Manager

DCC AVP for Design & Construction

DCC AVP for Code & Compliance

DFW Airport Operations

DFW Department of Public Safety

Off-Hours Work Protocol Page 1 of 2 September 2020
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7.0 OFF-HOURS WORK PROTOCOL L/ YV

OFF-HOURS INSPECTOR DAILY REPORT (IDR)

Any QA Inspector working off-hours must complete and submit their IDR, along with any
necessary supporting documentation (photos, quantity sheets, etc.) prior to leaving the job site.
This is imperative to ensure that important information about overnight construction activities is
available to the CM Team while the off-hours QA Inspector may be asleep.

SPECIAL CIRCUMSTANCES WITH NO QA COVERAGE DURING OFF-HOURS WORK

To effectively utilize staff resources, there are specialized circumstances where QA inspection
coverage may not be provided for off-hours work. The Procedures that will be implemented in
these special circumstances will be as follows:

e Before implementing a special circumstance, the QA Manager and Construction Manager
should confer and agree.

e Upon concurrence, the CM Team will advise the Contractor that there will not be QA
Inspection coverage of the off-hours work.

e The Contractor will be provided appropriate contact information and communication
protocols in the event of emergencies or unforeseen conditions.

e A Construction Quality Inspection assigned to another off-hours project, if there is one
happening concurrently, may randomly perform spot checks of the Contractor’s work.

e If an emergency situation arises, the Contractor shall follow the established communication
protocols as provided by the CM Team.

7.3 ATTACHMENTS
NONE

Off-Hours Work Protocol Page 2 of 2 September 2020



IN\[\A/

8.0 TIME AND MATERIAL (T&M) TRACKING kA
PROCEDURE

8.1 PURPOSE AND OVERVIEW

The purpose for this procedure is to outline the steps for tracking and documenting field order
work performed on a Time and Material (T&M) basis. This procedure should also be followed
when tracking work that could be potentially claimed by the Contractor as being outside the
Contract Documents.

The QA Inspector will inspect, track and verify all Contractor’'s work, personnel, equipment and
materials used, and ensure that the Contractor’'s Work Reports are accurate and completed on a
daily basis.

8.2 T&M TRACKING REQUIREMENTS

QA Inspector should keep track of all T&M work performed by the Contractor on a daily basis.

QA Inspector will be provided with appropriate documentation by the PM/CM Team to clearly
understand the scope of services the Contractor is to perform, along with any/all requirements
to be followed.

QA Inspector must track all work being performed on a Work Report when it is not covered in
the Contract Documents, or under a Field Order for future claims.

QA Inspector must keep an accurate record of personnel and time worked, equipment used,
and type and amount of materials used each day.

QA Inspector must ensure that any T&M work covered is annotated on their DCR and a copy
is attached.

Each day that work is performed on a T&M basis, the Contractor must provide the QA
Inspector with a Work Report signed by the Contractor.

QA Inspector must verify the accuracy of the Work Reports after receiving them from the
Contractor. Once satisfied with the report, the QA Inspector will sign the report and forward
it on to the CM Team

8.3 ATTACHMENTS

Time & Material Tracking Page 1 of 1 September 2020
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DFW AIRPORT

WORK REPORT

L7 VY

(1) D CONTRACT ADMIN. (ORIG.)

SHIFT12-8 00; 84 0:4-120 [ project MANAGER (2)

DATE OF WORK
)

Change No.

@) [J conrracror

Work Report # (5)

WORK REPORTS ARE TO BE MADE OUT DAILY WHEN EXTRA WORK
(AUTHORIZED OR UNAUTHORIZED) IS IN PROGRESS, AND MUST BE
INITIALED BY INSPECTOR AND SUBMITTED TO RESIDENT
ENGINEER FOR SIGNATURE DURING THE DAY FOLLOWING SUCH
WORK.

GENERAL CONTRACTOR (8)

SUBCONTRACTOR (10)

CONTRACT NO_(6)

CONTRACT NAME (7)

WORK DESCRIPTION, LOCATION, F.O. NO., SSC ITEM NO.
9)

LABOR / PERSONNEL (11)

EQUIPMENT USED (12)

NAME CLASSIFICATION HRS TYPE - MANUFACTURER - CAPACITY HRS
MATERIAL USED (13)
FULL DESCRIPTION QTY

TOTAL LABOR / PERSONNEL

CORRECT AS TO TIME, MATERIALS AND EQUIPMENT

(14)

Contractor DATE

11.0 T&M Example

SUBMITTED
(15)

TASpector DATE
(16)

Project Manager DATE

February 2020
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L/ VY

Work Report Form Directions

Reference the numbers on the preceding Work Report marked "Example". Follow the directions
below.

Number Title Directions

1 Shift One or more of the blocks need to be checked to
correspond with the amount of time worked by the
contractor, if applicable.

2 Contract Admin, Resident = Check the box of whom originated the form.
Engineer, Contractor

3 PCM Number Enter the Change No. associated with the T & M Work, if
applicable.

4 Date of Work Enter the date the work was performed on in format
Month. Day. Year (05.01.2018)

5 Work Report Number Enter the work report number or field order etc., if
applicable.

6 Contract Number Enter the contractor's DFW contract number

7 Contract Name Enter the project name

8 General Contractor Enter the primary contractor to which the contract was
awarded.

9 Work Description Enter a full description of the work activities, location,

field order number, and anything else needed to explain
the reason for the work report.

10 Subcontractor Enter the subcontractor that completed the described
work for the General Contractor.
11 Labor/Personal Enter each person performing the described work in #11

By: name, classification, and the total amount of hours
worked, straight time and over time.

12 Equipment Used Enter each piece of equipment required to complete the
work described in #12. Enter a full description, to include
type, manufacture, model number and hours used.

13 Materials Used Enter a full description and quantity of all materials used
that day.

14 Contractor's Signature Must have a signature from the contractor's
representative.

15 Inspector's Signature The Inspector that observed the described work will sign

the work report after he/she has verified the work report
against his/her Field Book and DCR.
16 Project Manager’s Signed by the Project Manager after reviewing.
Signature

11.0 T&M Instructions February 2020
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DFW AIRPORT

WORK REPORT

L7 VY

[ contracT Apmin. (ORIG.)
SHIFT 12-8 O0; 8-4 O0; 4-12 O D PROJECT MANAGER

Change No.  DATEOFWORK M .\ o\ ror

Work Report #

WORK REPORTS ARE TO BE MADE OUT DAILY WHEN EXTRA WORK
(AUTHORIZED OR UNAUTHORIZED) IS IN PROGRESS, AND MUST BE
INITIALED BY INSPECTOR AND SUBMITTED TO RESIDENT
ENGINEER FOR SIGNATURE DURING THE DAY FOLLOWING SUCH

WORK.

GENERAL CONTRACTOR

CONTRACT NO

CONTRACT NAME

WORK DESCRIPTION, LOCATION, F.O. NO., SSC ITEM NO.
)

SUBCONTRACTOR
LABOR / PERSONNEL EQUIPMENT USED
NAME CLASSIFICATION HRS TYPE - MANUFACTURER - CAPACITY HRS
MATERIAL USED
FULL DESCRIPTION QTY
TOTAL LABOR / PERSONNEL
CORRECT AS TO TIME, MATERIALS AND EQUIPMENT SUBMITTED
Inspector DATE
Contractor DATE Project Manager DATE
11.0 T&M Blank February 2020
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Xll. APPENDIX

Definitions and Acronyms

QF and NCR Rework Matrix

Protection of Existing Utilities

QA Manual ii. SEPTEMBER 2020



IN\[\A/

L1 VY
DEFINITIONS and ACRONYMS

BIM360: Autodesk digital platform for QA and CM services
documentation.

CQC: Contractor Quality Control
DFW: DFW International Airport, also referred to as “Owner.”
DCC: DFW’s Design, Code and Construction Department.

Daily Quantities / Pay Items: Source document showing records of the
actual and/or estimated measurements and calculations of line item
quantities installed for which payment will be made.

Inspection: The observation, documentation and verification of the
definable feature of work’s compliance with the contract and/or
specifications.

IDR: Inspector Daily Report. This is the daily electronic report required to
be completed and filed by each QA Inspector within 24 hours of the
conclusion of his/her shift. It provides detailed information about all
construction-related activities that occurred and were observed by the QA
Inspector during his/her shift.

Issue or Deficient Condition: Any circumstance for a variety of reasons
that does not conform to the lines and grades of the contract documents,
general provisions or technical specifications. A Deficient condition is only
identified in this manner. It only is defined as something deficient. The
reason for the deficiency will vary.

Management: DFW’s Senior Executives, along with DCC’s Vice-
President and Assistant Vice Presidents.

Materials Inspection Report: Sheet that tracks all inspected materials
related to a particular line item. All materials must be inspected prior to
the material being incorporated into a project.

Non-Conformance Condition: Any condition not in compliance with the
contract documents which cannot expediently be resolved through the
Deficiency Notification Procedure.

Observation: To watch carefully, with attention to details, for the purpose
of arriving at a judgment or assessing status.

Owner: DFW International Airport, also referred to as “DFW.”

Project Personnel: Any/all personnel performing Program / Project or
Construction Management, including staff augmentation and consultants.

Project QA Manual Page 1 of 2 Definitions and Acronyms
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L1 VY

PRCF: Procedure Review Comments Form

Procedures Committee (PC): The group of DCC managers

responsible for periodic review and update of this manual to ensure that
the policies and procedures are up to date with the industry standard, are
reflective of the best practices that is DCC’s goal, and that the procedures
are accurate and useful. The PC shall consist of DCC’s QA Manager,
AVP of Code and AVP of Design & Construction.

Quality Assurance: The process or procedure the Owner will follow to
ensure that the required quality of the project is achieved.

Quality Control: The plans, policies and procedures developed for and
used by the Contractor to control the workmanship of a project.

Quantity Book: The keystone of the complete record keeping structure
for a construction project. Daily quantities are to be posted in the Quantity
Book.

Quantity Book Sheet: Sheet that tracks the daily entries of quantities
installed on each contract. This sheet contains all information about a
particular line item, including daily quantities installed; quantities installed
to date; and authorized increases or decreases to quantities.

Request for Inspection of Material Form (RFIM): The form the
contractor submits when there is new material to be inspected.

Root Cause: The base reason that the deficient condition exists. The
root cause will vary and can be related to one or more issues.

T&M: Time and Materials.
Unifier: Oracle’s digital platform for Project Management at DFW.

Work Report: Source document used to record actual labor, equipment,
and materials used for Field Order work and work performed outside
contract documents.

Project QA Manual Page 2 of 2 Definitions and Acronyms
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Quality Rework Incident Report

HCrQCT

Company: Josh Grable Excavating Project Superintendent: Peter Florian
Project: lllinois Rt. 49 Rehab. Project Manager: Chris Neven
Job Number: P00956 Project Engineer: Chad Case
Earned Manhours: 20,523 e/ Manager: Nathan Riiff
Total Cost: $5,460 riod Ending: Oct-18
# of Incidents: 4 Goals: R. Factor = 0.30; Q. Freq. = Min. 30
Rework Factor: | 0.27 Quality Frequency:: [ 39.0

Total Cost / Earned Manhours

(Number of Incidents x 200,000) / Earned Manhours

Rework Factor Graph: Quality Frequency Graph:
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0.3 » = = - - =03 259 A 42.3
. UO Uo Uo U, O U, O B 400 = .D
0.25 A 027 _ 350 N\ I
s 02 / 3 300 —Heﬂ#@o—l—aeﬁv#l%&
5 / S 250 ¥ 256
3 0.15 o454 = /
& Pl —01 g 200
0.1 ' L 150 //
0.05 —Eﬂﬂﬁﬁ/ © 100
0.04 50
0 .
& @ N © o & 0.0 :v/ 0.0 N N N n
v » 3 S ® 3 g < S N ¢
\?9 @Q@é\ ¥ N ¥ > ‘?gq \Q'&Q
S &
Month Month @
—+—Rework Factor ~ —#— Job Goal ‘ —— Quality Frequency ~ —#— Job Goal

Quiality Rework

October 1, 2018




Rework Input Data

Rework Graph

Month
April

May

June

July
August
September

Rework Data

2018 Rework Factor Acceptable Job Goal
0.06 0.3
0.04 0.3
0.15 0.3
0.14 0.3
0.12 0.3
0.27 0.3

™NI[\A/
L/ VY

October 1, 2018



Qfrequency Data

Month Number of incidents Manhours report
April 0 0.00
May 1 200,000.00
June 2 400,000.00
July 3 600,000.00
August 2 400,000.00
September 4 800,000.00

QFrequency Data

Earned Mahhours
150.00

6,667.00
12,500.00
14,200.00
16,000.00
20,523.00

QF
0.0
30.0
32.0
42.3
25.0
39.0

MICTAA

7

L/l VvV

Goal

October 1, 2018

30
30
30
30
30
30



Protection of Existing Underground Utilities & Cables

Always Assume All Utilities Are Active & Live

If sand or bedding materials are encountered during excavations, operations shall immediately
cease and notification to the contractor’s management team is required.

Always refer to the project specifications concerning Protection of Utilities & Cables prior to
excavations being performed. Contractors are required to develop & maintain a project Dig
Book ( Utility Locate Document ). This document should provide the location & elevation for
each individual utility. At the beginning of each work shift, verify the location of each proposed
excavation area and then verify the previously located utilities within the area. Both the OAR &
contractor must complete the “ Utility Location Sign-Off Sheet” prior to excavations being
performed to confirm that the existing cables / utilities have been previously located.

It is the sole responsibility of the contractor to locate all utilities on the construction site, except
for FAA lines. All utilities discovered during the construction process shall be protected by the
contractor. The contractor shall immediately repair any damaged utilities encountered.

The contractor will provide immediate notification to the OAR and provide a written report of
the incident.

If a utility is discovered , but not damaged, the OAR shall contact the DFW Airfield Operations
Officer ( Port 102 ) and inform of assumed utility found.

If a utility is damaged, immediately inform:

DFW Airfield Operations Officer via AOA Radio or call 972-973-3121
Airport Operations Center ( AOC) @ 972-973-3112
Call Jason Brimingham & Demetric Larry for notification.

HwnN e

Email the project CM, Demetric Larry, & Jason Brimingham to notify of damage.

Inform both of assumed utility damaged and provide area location of the damage.

An “ Underground Utilities Damage Report” should be completed by the OAR and upon
completion be emailed to:

1. DFW Airfield Operations Officer & DFW Operations Compliance Officer @

AirfieldOfficers@dfwairport.com & frebarchik@dfwairport.com

And copy the Project CM, Demetric Larry, & Jason Brimingham
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Xlll. DFW PROJECT QUALITY ASSURANCE MANUAL
RECEIPT AND AGREEMENT

l, , have received the DFW Project Quality
Manual. (Printed Name of Recipient)

By signing, | agree that | will read, understand and apply all these procedures that have
been presented to me in this manual.

| will follow the procedures identified and abide by all the established rules, regulations
and frequencies found in this manual.

The manual will be the “unit of measure” for myself, going forward and will be
considered the metric of how | am performing as a Construction/Quality Professional on
all projects at DFW.

DFW reserves the right to revise and supplement the forgoing rules from time to time as
may be necessary to maintain this manual’s usefulness in this industry.

Upon layoff, termination or leave of absence, | agree to turn in all the items that have
been provided me inclusive of this manual.

(Printed Name of recipient) (Signature of Recipient) Date

(Printed Name (Signature of Quality Administrator) Date
of Quality Administrator)

Disclaimer:

This manual is copy written in accordance with the Copyright Act of 1976 and the
content cannot be reproduced, downloaded, disseminated, published or transferred in
any form or by any means, except with the prior written permission of the original author
and publisher. Any such information contained in this Plan is covered by the United
States Copyright Law and United States Circular 92.
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